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Introduction 
 
 
 
 
 
 
 

Welcom to ADGIS, a geographical information system which allows users 
to geographically search for information regarding access for specific 
locations or areas.  ADGIS was developed with ESRI’s Map Objects 
component software and Microsoft Visual Basic.  ADGIS works with the 
Access Determination Tracking System Application created for tracking 
the process of access determination requests.  ADGIS in its current state is 
an executable file located on the individual’s hard drive.  It is anticipated 
that the general users of ADGIS will eventually be logging into an Intranet 
application and use a browser to communicate to the system. 

 

System Installation & Setting Environmental Variables 
 
The application data files and information needs to be in a location where 
they will be stored and maintained, on a network drive.  Remember this 
location because it will be needed when you set the variables in the .ini 
files that are located on the hard drive of the user with the executable 
program. 
 
Next install the executable file on the personal/desktop computer.  This 
install will copy dll files and the executable file to your computer and 
install them similar to a software installation.  As stated previously, 
ADGIS requires the setting of variables in two .ini files on the desktop 
computers.   This task is typically only available for system 
administrators.   

 
 The following variables are utilized in the .ini files: 

1. File Name: Paths.ini 
This file contains the paths for the location of the 
datasets and images that are utilized in the application. 

2. File Name: Counties.ini 
This file contains information about the specific county 
datasets, including county name, type of file, path of 
file location, shapefile name and critical field in the 
dataset that is used to link the datasets together with the 
databases. 
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Learning ADGIS 
Once the user is familiar with a few basic terms and the location of key 
items, the Access Determination Application should be easy to navigate.  
Upon opening of the Access Determination Application the user will see 
the screen displayed below.  The use of each tool on the ADGIS screen are 
explained in detail in the following section of this user’s guide. 

 
 

Pull Down Menus 
You will use the “Pull Down” menus to access most of the tools available 
to view, query and create output of information from the application. 

 

 To access a menu item. 

1. Move the mouse point to any of the menu items. 

2. Left Mouse Click on a menu item to see a list of options 
that are available for that item. 

 
 

2 
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 A brief description of each menu item. 

As the user moves forward through The User Manual, each 
item will be discussed in more detail when it is used for a 
specific task. 

1. Display Menu 
Allows the user to turn on the display manager and turn 
on/off the aerial photography. 

2. Locate Menu 
Allows the user to locate by county, city/village/town, 
certified survey map, subdivision, driveway, parcel (by 
owner, property identification number or address) or 
street intersection.  The Locate Menu also allows the 
user to clear all queried information. 

3. Load County Menu 
Allows the user to load the county specific data 
(parcels, access points, subdivision/CSM/condo and 
local roads). 

4. Info Menu 
Allows the user to get information associated with 
CSM’s, subdivisions, city/village/towns, driveways, 
road segments (street names, meta-manager 
information, state trunk network data and connecting 
highways) and right-of-way plats.  There is also a 
function to locate information on everything and 
summarize it. 

5. Tools Menu 
Allows the user to measure an item or distance, modify 
all of the data layers, place street labels and notes or 
create a mailing list. 

6. Print Menu 
Allows the user to print what is on the screen. 

7. Database Menu 
Allows the user to open the tracking system from the 
application. 

8. About Menu 
Allows the user to view a little background information 
about the application. 

 

Overview Map 
You will use the “Overview Map” to locate where you are at in the map 
screen in comparison to the overall area of the application.  You can also 
use the overview map to adjust your location in the map screen. 
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 To use the overview map. 

1. Move the cursor into the area of the overview map. 

2. Left Mouse Click a point on the screen, hold down the left 
mouse button and drag the cursor to the extent of where 
you want to view and release the left mouse button. 

3. The map screen should refresh to this location and a box 
will appear on the Overview Map to show the area you 
have selected. 

 
 

Display Controls 
The Display Controls provide several different navigational and 
magnification features.  Each control accomplishes different movements 
and views within the map screen.  To use the display controls left mouse 
click the control that you would like to use. 

 

Tip By sliding the cursor over each of the icons, a yellow text box will 
tell the user what function the icon has. 

 
 A brief discription of the display controls. 

1. Zoom In 
Allows the user to zoom into an area by magnifying the scale of 
the map screen when the button is selected. 

2. Zoom Out 

Allows the user to zoom out from an area by minimizing the scale 
of the map screen when the button is selected. 

3. Zoom Area 

Allows the user to zoom into a specific area on the map screen by 
using the left mouse click on the start of the area and hold down 
the left mouse button to drag the box to the second point.  This tool 
can also be used on the Overview Map.   

4. Directional Arrows 

Allows the user to move by a distance of 1/3 of the viewing area in 
the direction of the particular arrow selected.  The up arrow moves 
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north, the right arrow moves east, the down arrow moves south, 
and the left arrow moves west. 

5. Pan 

Allows the user to left mouse click the map screen and drag the 
screen to an area once the button is selected.  Pan is defined as the 
movement of the screen in a specific direction and distance as 
directed by the user.  The Pan Tool will not function when the map 
screen is in the world view. 

6. World View 
Allow the user to zoom to the complete extents of the mapping in 
the application when the button is selected. 

 

Push Button Controls 
The Push Button controls located at the right of the map screen allow the 
user to quickly access certain features without utilizing the pulldown 
menus.  The Display Manager and Load County controls will be explained 
in the chapters of the user’s guide. 

 

 To use the Show Legend. 

1. Left Mouse Click the “Show Legend” button located 
at the right on the map screen.  This will display the 
“Legend” pop up window. 

2. Select the “x” in the upper right corner of the 
“Legend” pop up window to close the window. 

 
 

Database 
To access the information that is used in the Access Determination 
Tracking System, left mouse click the “Database” menu option and select 
the “Open Database” option from the list.  This will open the Tracking 
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System from which the user can add or adjust the data as needed.  Once 
open, it will look similar to the screen displayed below. 

 
 

Command Display 
In the lower left corner of the screen is the Command Display.  This 
display shows the last command or action you performed using the menus 
or the Display Controls.   For instance, if the user located the Birnam 
Wood subdivision, the Command Display line will show “Locate > 
BIRNAM WOOD”. 
 
Throughout the use of this application the Command Display will direct 
the user on what to do.  If ever in doubt as to the current function or the 
next step to take, utilize the Command Display. 

 
 

Scale Bar 
The Scale Bar is located in the lower left corner of the map screen, inside 
the map limits.  The scale bar indicates the scale of the map at any given 
moment based on the zoom amount.  This feature also allows the user to 
print the screen at any given moment and have the scale of the map 
available to correspond to the print. 

Command 
Display 
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X:Y Coordinate Readout 

 
The X: Y Coordinates are located on the bottom left of the screen.  The 
coordinate readout allows the user to locate coordinately where they are, at 
any given moment, just by the movement of their cursor on the screen. 
 
The coordinates displayed are Wisconsin Transverse Mercator NAD27.  
 

 

 

 

Scale 
Bar 

X:Y Coordinate 
Readout 
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Loading County Information 
 
 
 
 
 
 
 
 

This chapter is the first step in working with the system.  
You will need to know how to load a county before you 
will beable to work with some of the main functions.  If 
a user would like specific information about parcels, and 
how the data relates to them, load the detailed data for a 
specific county. 

 

Note If the information sought is generalized 
information about a segment of roadway or an 
intersection, you may proceed to utilize the application 
in its current state. 

 

 

Chapter Contents 

2 Load a County 
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Load a County 
 

You will use the “Load County” menu option located at 
the top or the “Load County” button located on the right 
side, of the Access Determination Application display. 

 

 To load a county 
1. Left mouse click the “Load County” menu option 

located on the menu bar at the top of the screen.  This 
will open an external pop up window with a list of 
the available counties. 

2. Left mouse click to select the county for which you 
would like to find information. 

3. Select the “Load” button located at the bottom of the pop 
up window. 

4. The county will be highlighted on the overview map 
located at the top, right on the display and the local 
information will appear on your map screen if the county 
information successfully loaded. 

Tip The local data only displays when the main map 
screen is zoomed in to a small enough scale.  This is 
done due to the large amount of data that gets displayed. 

 
 

Example: 

 

 

2 

3 
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Using Display Options 
 
 
 
 
 
 

This chapter explains how to turn layers on and off and 
how to view aerial photos with the map. 

 

Chapter Contents 

4 Display Manager 

5 Display Aerial 

5 Unload Aerials 

5 Information About Aerial Files 
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Display Manager 
 
You will use the “Display Manager” button located at 
the right or the “Display” menu option located at the top 
left of the Access Determination Application display. 
 

 To use the display manager 
1. Select the “Display Manager” button located at the 

right of the screen or Left mouse click the “Display” 
menu option located on the menu bar at the top of the 
screen and then select the “Display Manager” option 
from the Display list.  This will open the “Display 
Manager” pop up window. 

2. On the “Display Manager” window check or uncheck 
the items that you would like to view as layers on the 
map screen. 

3. Select the “Update Display” button to have the 
request take affect. 

 
 
Note The more options check marked the slower the 
system will run. 

 

2 

3 
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Display Aerial 
 
This option will allow you to display Aerials. 
 

 To display an aerial. 

1. Left Mouse Click the “Display” menu option located 
in the top, left corner of the screen. 

2. Select the “Aerial” option from the menu options. 
3. Left Mouse Click on the map where the aerials need 

to be displayed. 
 

Unload Aerials 
 
This option will allow you to remove previously 
displayed Aerials. 
 

 To unload aerials. 

1. Left Mouse Click the “Display” menu option located 
at the top of the screen. 

2. Select the “Unload Aerials” option from the Display 
list. 

3. Left Mouse Click on the map where the aerial is 
displayed. 

 

Information About Aerial Files 
 
The aerial files are orthophotographs that are distributed by the 
South East Wisconsin Regional Planning Commission (SEWRPC).  
These series of photos are from the 2000 flight.   
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Locating Items 
 
 
 
 

This chapter explains how to quickly locate items by 
County, CSM, City, Village, Town, Driveway, Parcel, 
Quarter Section, Subdivision, or Street Intersection. 
 

Tip At any time in the program, right click the mouse to 
cancel the last command that you entered.  For instance, 
after selecting Street Intersection from the Locate Menu, 
right click and the Street Intersection window will 
become inactive. 
 
Chapter Contents 

 7 Locate County 

8 Locate Trans233 

9 Locate Conceptual 

10 Locate City,Village, Town 

11 Locate Driveway 

12 Locate Parcel 

15    Locate Road Permit 

16 Locate Quarter Section 

17 Locate Subdivision 

18 Locate Street Intersection 
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Locate County 
 

 To locate a county 

1. Left Mouse Click the “Locate” menu option located 
at the top of the screen. 

2. Select the “County” option from the Locate list.  This 
will bring up a list of counties available to locate. 

3. Left Mouse Click a county from the list. 
4. Select the “OK” button located at the bottom of the 

pop up window. 

 
 

Note Notice that when the county is selected the main 
display will be re-centered around that county and the 
county area is highlighted.  The Overview Map will also 
draw a box around the county to show its location in 
relation to the entire dataset.  
 

1 

3 

4 
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Locate Trans233 
 

 To locate a Trans233 
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Trans233” option from the Locate list.  

This will bring up a list of Trans233’s available to 
locate. 

3. Type the Trans233 number into the textbox located 
at the top of the “Locate by Trans233” pop up 
window or Left Mouse Click the Trans233 number 
from the list. 

4. Select the “OK” button.  The screen will zoom to the 
area where the Trans233 is located. 

 
 
Tip After selecting the Trans233, the screen may be 
zoomed in too close to determine the location on the 
map. Click the Zoom Out icon on the Display Controls, 
the map will zoom out and allow the user to align where 
they are in conjunction to the surrounding area.  The 
Trans233 number selected will appear in bold print 
centered within the Trans233 boundaries. 

1 

3 

4 
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Locate Conceptual 
 

 To locate a Conceptual 
1.  Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Conceptual” option from the Locate list.  

This will bring up a list of Conceptuals available to 
locate. 

3. Type the Conceptual number into the textbox located 
at the top of the “Locate by Conceptual” pop up 
window or Left Mouse Click the Conceptual number 
from the list. 

4. Select the “OK” button.  The screen will zoom to the 
area where the Conceptual is located. 

 
 
Tip After selecting the Conceptual, the screen may be 
zoomed in too close to determine the location on the 
map. Click the Zoom Out icon on the Display Controls, 
the map will zoom out and allow the user to align where 
they are in conjunction to the surrounding area.  The 
Conceptual number selected will appear in bold print 
centered within the Conceptual boundaries. 

1 

3 

4 
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Locate City, Village, Town 
 

 To locate a City, Village, Town 
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 

2. Select the “City, Village or Town” option from the 
Locate list.  This will bring up a list of Municipalities 
available to locate. 

3. Type the City, Village or Town into the textbox 
located at the top of the “Locate by” pop up window 
or Left Mouse Click the City, Village or Town from 
the list. 

4. Select the “OK” button.  The screen will zoom to the 
area where the City, Village, or Town is located. 

 
 

Tip After selecting the City,Town,Village, the screen 
may be zoomed in too close to determine the location on 
the map. Click the Zoom Out icon on the Display 
Controls, the map will zoom out and allow the user to 
align where they are in conjunction to the surrounding 
area. 

4 

3 

1 
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Locate Driveway 
 

 To locate a driveway 
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Driveway” option from the Locate list.  

This will bring up a list of Driveways available to 
locate. 

3. Type the Driveway number into the textbox located 
at the top of the “Locate by Drive…” pop up window 
or Left Mouse Click the Driveway number from the 
list. 

4. Select the “OK” button.  The screen will zoom to the 
area where the Driveway is located. 

 
 

Tip At any time, either zoomed in or at full extent, 
the user can clear the last item you located.  Use the 
Locate Menu and Clear Located Item(s). 

 

Tip After selecting the driveway, the screen may be 
zoomed in too close to determine the location on the 
map. Click the Zoom Out icon on the Display Controls, 
the map will zoom out and allow the user to align where 
they are in conjunction to the surrounding area. 

4 

3 

1 
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Locate Parcel 
 

 To locate Parcel by Owner Name 
This option allows the user to input all or part of an 
owner’s name. 
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Parcel” option from the Locate list.  This 

will bring up a search form. 
3. Type the First and Last Name of the Owner you 

would like to locate into the First Name and Last 
Name textboxes located in the “Name” box at the top 
of the “Locate Parcel” pop up window.  

4. You may also type the start of the First and Last 
Name of the Owner you would like to locate and 
check mark the “Find Like Matches” located below 
the First Name textbox. 

5. Select the “Locate” button located inside the “Name” 
box at the top of the “Locate Parcel” pop up window. 

6. Left Mouse Click the name of the owner you would 
like to locate from the listbox located at the bottom 
left of the “Locate Parcel” pop up window.  The 
parcel of the owner selected will be displayed in 
green on the map screen. 

 

3 4 

4 

1 

5 

6 



Chapter 3   Locationg Items  13 

 

 
 To locate Parcel by Address 

This option allows the user to enter the owner address or 
part of the owner address.  
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Parcel” option from the Locate list.  This 

will bring up a search form. 
3. Type the address of the Owner you would like to 

locate into the Street Address textbox located in the 
“Address” box in the middle of the “Locate Parcel” 
pop up window.  

4. You may also type the start of the address of the 
Owner you would like to locate and check mark the 
“Find Like Matches” located below the Street 
Address textbox. 

5. Select the “Locate” button located inside the 
“Addres” box in the middle of the “Locate Parcel” 
pop up window. 

6. Left Mouse Click the address of the owner you 
would like to locate from the listbox located at the 
bottom left of the “Locate Parcel” pop up window.  
The parcel of the owner selected will be displayed in 
green on the map screen. 

 
 

5 

1 

6 
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 To locate Parcel by PIN(Parcel Identification Number) 

This option allows the user to enter the PIN, which is the 
unique identification number created for each parcel, by 
the county.  
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Parcel” option from the Locate list.  This 

will bring up a search form. 
3. Type the PIN of the Owner you would like to locate 

into the Parcel Identification Number textbox located 
in the “PIN” box in the middle of the “Locate Parcel” 
pop up window.  

4. You may also type the start of the PIN of the Owner 
you would like to locate and check mark the “Find 
Like Matches” located below the Street Address 
textbox. 

5. Select the “Locate” button located inside the “PIN” 
box in the middle of the “Locate Parcel” pop up 
window. 

6. Left Mouse Click the PIN of the owner you would 
like to locate from the listbox located at the bottom 
left of the “Locate Parcel” pop up window.  The 
parcel of the owner selected will be displayed in 
green on the map screen. 

 

1 

5 

6 
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Locate Road Permit 
 

 To locate a road permit 
5. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
6. Select the “Road Permit” option from the Locate list.  

This will bring up a list of Driveways available to 
locate. 

7. Type the Road Permit number into the textbox 
located at the top of the “Locate by Road…” pop up 
window or Left Mouse Click the Road Permit 
number from the list. 

8. Select the “OK” button.  The screen will zoom to the 
area where the Driveway is located. 

 
 

Tip After selecting the road permit segment, the 
screen may be zoomed in too close to determine the 
location on the map. Click the Zoom Out icon on the 
Display Controls, the map will zoom out and allow the 
user to align where they are in conjunction to the 
surrounding area. 

 

 

4 

3 

1 
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Locate Quarter Section 
 

 To locate a quarter section 
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Quarter Section” option from the Locate 

list.  This will display the “Locate Quarter Section” 
pop up window. 

3. Type the Section, Town, Range, and Quarter of the 
Quarter Section you would like to locate into the 
textboxes located at the top of the “Locate Quarter 
Section” pop up window.  

4. You may also select the Section, Town, Range, and 
Quarter you would like to locate from the listboxes 
located below each textbox on the “Locate Quarter 
Section” pop up window. 

5. Select the “Locate” button.  The Quarter Section 
selected will be displayed in green on the map 
screen. 

 

 
 
Note You must enter all four fields to locate by 
Quarter Section. 
 

1 

3 

5 

4 
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Locate Subdivision 
 

 To locate a Subdivision 
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Subdivision” option from the Locate list.  

This will display the “Locate by Subdivision” pop up 
window. 

3. Type in the textbox located at the top of the “Locate 
by Subdivision” pop up window to jump to the 
subdivision name in the list displayed in the middle 
of the “Locate by Subdivision” pop up window. 

4. Select the Subdivision you would like to locate from 
the list. 

5. Select the “OK” button.  The Subdivision selected 
will be displayed in green on the map screen. 

 
 

 

1 
3 

4 

5 
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Locate Street Intersection 
 

 To locate a Street Intersection 
1. Left Mouse Click the “Locate” menu option located 

at the top of the screen. 
2. Select the “Street Intersection” option from the 

Locate list.  This will display up the “Locate 
Intersection” pop up window. 

3. Select the road you would like to locate from the 
listbox located below the Road Type options on the 
“Locate Intersection” pop up window. 

4. Select the intersecting roadway from the listbox 
located at the bottom of the “Locate Intersection” 
pop up window.  The Street Intersection selected will 
be displayed in green on the map screen. 

 
 

Note  You may need to zoom in or out and turn Street 
Labels on to see both road names. 

 

1 

3 

4 

Select Roadway 
From List 
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Info 
 

 

 

 

This chapter will explain how to use the Info Menu.  The 
Info Menu allows the user to identify what information 
will be displayed when they select an item on the map 
screen.  This feature also allows users to identify any 
Trans233’s, Subdivision’s, Driveway’s, Right-of-Way 
Plats, MetaManager Segments, etc. that are with in 50 
feet of the selected item. 
 
Chapter Contents 
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Summary By Parcel 
 

 To get info by Parcel 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “Summary By Parcel” option from the Info 

list.  Your mouse pointer will become an arrow with 
an i. 

3. Left Mouse Click the parcel for which you would 
like to view information.  This will display the 
“Access Determination Summary” pop up window. 

4. The “Parcel Information” listbox located at the left of 
the pop up window displays the information from the 
county for the selected parcel. 

5. The “Additional Data Type” listbox located at the 
top, right of the pop up window allows the user to 
locate near by Subdivisions, Trans233, etc.  Select an 
item from this list. 

6. The “Matches” listbox below the “Additional Data 
Type” listbox displays what matches were found for 
the item selected.  If none were found this will also 
be displayed. 

7. Select an item from the “Matches” listbox to display 
the information for this item in the “Details” listbox 
located below the “Matches” listbox on the pop up 
window. 

 
Note When an image is available for a selected item in 
the “Matches” listbox the “View Image” button with be 
displayed.  The user’s computer must have Adobe 
Acrobat Reader installed in order to view these images.   

4 

1 

7 

6 
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On Trans233(CSM) 
 

 To get info by Trans233(CSM) 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Trans233(CSM)” option from the Info 

list.  Your mouse pointer will become an arrow with 
an i. 

3. Left Mouse Click the Trans233 for which you would 
like to view information.  This will display “View 
Trans233(CSM) Details” pop up window. 

4. Select the Trans233 for which you would like to 
view information from the listbox located at the left 
on the pop up window.   

5. The detailed information is displayed in the listbox 
located at the right on the pop up window. 

6. Select the “View Image” button to display the image 
for this Trans233. 

 
 
Note When an image is available for the selected 
Trans233 the “View Image” button with be enabled.  The 
user’s computer must have Adobe Acrobat Reader 
installed in order to view these images.   

 

1 

4 

6 
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On Conceptual 
 

 To get info by Conceptual 
7. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
8. Select the “On Conceptual” option from the Info list.  

Your mouse pointer will become an arrow with an 
i. 

9. Left Mouse Click the Conceptual for which you 
would like to view information.  This will display 
“View Conceptual Details” pop up window. 

10. Select the Conceptual for which you would like to 
view information from the listbox located at the left 
on the pop up window.   

11. The detailed information is displayed in the listbox 
located at the right on the pop up window. 

12. Select the “View Image” button to display the image 
for this Conceptual. 

 
 
Note When an image is available for the selected 
Conceptual the “View Image” button with be enabled.  
The user’s computer must have Adobe Acrobat Reader 
installed in order to view these images.   
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On City, Village, Town 
 

Left Mouse Click the “Info” menu option located at the top 
of the screen.  Select the “On City, Village, Town” option 
from the Info list. Your mouse pointer will become and 
arrow with an i.  As you move your mouse around on the 
map screen the name of the Municipality will be displayed 
in a yellow box. 

 

On Driveway 
 

 To get info by Driveway 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Driveway” option from the Info list.  

Your mouse pointer will become an arrow with an 
i. 

3. Left Mouse Click the driveway line for which you 
would like to view information.  This will display the 
“Info on drives” pop up window. 

4. The listbox displays the information for the selected 
driveway. 
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On Road Permit 
 

 To get info by Road Permit 
5. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
6. Select the “On Road Permit” option from the Info 

list.  Your mouse pointer will become an arrow with 
an i. 

7. Left Mouse Click the road permit line for which you 
would like to view information.  This will display the 
“Info on road permit” pop up window. 

8. The listbox displays the information for the selected 
driveway. 
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On Quarter Section 
 

 To get info by Quarter Section 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Quarter Section” option from the Info 

list.  Your mouse pointer will become an arrow with 
an i. 

3. Left Mouse Click the Quarter Section for which you 
would like to view information.  This will display the 
“Info on quarter sectio…” pop up window.  The 
quarter section selected will be displayed in the 
listbox on the pop up window.   

4. Holding your mouse over the quarter section will 
display a yellow box with the quarter section 
information. 
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On Road Segment 
 
This feature allows you to get information on road 
segements through four different means. 
 

 To get info by Street Name 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Road Segment” option from the Info 

list. 
3. Select the “Street Name” option from the On Road 

Segment list.  Your mouse pointer will become an 
arrow with an i. 

4. As you move your mouse around on the map screen 
the street name will be displayed in a yellow box. 
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 To get info by Meta-Manager 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Road Segment” option from the Info 

list. 
3. Select the “Meta-Manager” option from the On Road 

Segment list.  Your mouse pointer will become an 
arrow with an i. 

4. Left Mouse Click on a State Trunk Highway. This 
will display the “Info on Meta-Manager” pop up 
window. 

5. The listbox on the “Info on Meta-Manager” pop up 
window displays the data that the Meta-Manager 
system has on the selected segement of highway. 

 
 
Note The Meta-Manager data is a compilation of highway 
information.  Its overlying goal is to provide information on 
deficiencies on the state’s highway system.  It includes 
specific information on crashes – including the type and the 
segment where they occur, traffic data including Level of 
Service and projections, as well as the pavement conditions. 
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 To get info by State Trunk Data 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Road Segment” option from the Info 

list. 
3. Select the “State Trunk Data” option from the On 

Road Segment list.  Your mouse pointer will become 
an arrow with an i. 

4. Left Mouse Click on a State Trunk Highway. This 
will display the “Info on state trunk n…” pop up 
window. 

5. The listbox on the “Info on state trunk n…” pop up 
window displays the data for the selected segement 
of highway. 
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 To get info by Connecting Hwy 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Road Segment” option from the Info 

list. 
3. Select the “Connecting Hwy” option from the On 

Road Segment list.  Your mouse pointer will become 
an arrow with an i. 

4. Left Mouse Click on a Highway. This will display 
the “Info on connecting hwy“ pop up window. 

5. The listbox on the “Info on connecting hwy” pop up 
window displays the data for the selected segement 
of highway. 
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On ROW Plats 
 

 To get info by ROW Plat 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On ROW Plats” option from the Info list.  

Your mouse pointer will become an arrow with an i. 
3. Left Mouse Click on a ROW line. This will display the 

“View ROW Plat Details“ pop up window.  The 
listbox on the left of the pop up window displays a list 
of all ROW Plats selected. 

4. Select one of the plats listed in the listbox located on 
the left of the pop up window and it will display 
information in the listbox located on the right of the 
pop up window. 

5. Selecting an item from the listbox located on the right 
side of the pop up window will allow you to view an 
image of the ROW Plat if one is available. 

6. Select the “View Image” button located at the bottom 
of the pop up window to view the selected image. 

 
 
Note When an image is available for the selected ROW 
Plat the “View Image” button will be enabled.  The 
user’s computer must have Adobe Acrobat Reader 
installed in order to view these images.   
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On Subdivision 
 

 To get info by Subdivision 
1. Left Mouse Click the “Info” menu option located at 

the top of the screen. 
2. Select the “On Subdivision” option from the Info list.  

Your mouse pointer will become an arrow with an i. 
3. Left Mouse Click on a Subdivision. This will display 

the “View Subdivision Details“ pop up window.  The 
listbox on the left of the pop up window displays a list 
of all Subdivisions selected. 

4. Select one of the subdivisions listed in the listbox 
located on the left of the pop up window and it will 
display information in the listbox located on the right 
of the pop up window. 

5. Selecting an item from the listbox located on the right 
side of the pop up window will allow you to view an 
image of the Subdivision Plat if one is available. 

6. Select the “View Image” button located at the bottom 
of the pop up window to view the selected image. 

 
 
Note When an image is available for the selected 
Subdivision the “View Image” button with be enabled.  
The user’s computer must have Adobe Acrobat Reader 
installed in order to view these images. 
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C H A P T E R  5  

 

Tools 
 
 
 
 
 
 
 
 

This chapter will explain how to use the Tools Menu.  
The Tools Menu offers an array of options for measuring 
and modifying elements within the Access 
Determination Application. 
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Measure 
 
The Measure Tool is used to calculate the distance 
between two points on the map screen. 
 

 To use the Measure Tool 
1. Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
2. Select the “Measure” option from the Tools list.  Your 

mouse pointer will become a cross symbol. 
3. Left Mouse Click the starting point of the object you 

would like to measure. 
4. Double Left Mouse Click the ending point of the 

object you would like to measure.  This will display 
the “Measure” pop up window with the distance 
shown in meters and feet. 
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Measure Minimum Distance 
 
The Measure Minimum Distance Tool is used to 
calculate the minimum distance between two objects.  
 

 To use the Measure Minimum Distance Tool 
1. Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
2. Select the “Measure Minimum Distance” option from 

the Tools list.  Your mouse pointer will become a 
cross symbol. 

3. Left Mouse Click the first object you would like to 
start measuring. 

4. Left Mouse Click the second object you would like to 
finish measuring.  This will display the “Measure” pop 
up window with the distance shown in meters and feet. 

 
 
Note This distance is the minimum distance between two 
items and may not reflect an actual distance between two 
points. 
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Driveway 
 
The Driveway Tool allows the user to add, modify or 
remove driveways from the map screen.   
 

 To add a driveway. 
1. Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
2. Select the “Driveway” option from the Tools list. 
3. Select the “Add” option from the Driveway list.  This 

will display the “Add Driveways” pop up window. 
4. Select the “Draw Driveway On Map” button.  Your 

mouse pointer will become a pencil symbol. 
5. Left Mouse Click on the map screen where the 

driveway is to be placed, keep selecting points until 
the last point is entered. 

6. Double Left Mouse Click the last point to add the line 
to the map screen. 

7. Select the “Get an Available Driveway Number” 
button or Enter the Driveway Number. 

8. Select the “Get” button to select a permit number and 
ID number from the database. 

9. If you have the RP Number you may also enter this. 
10. Select the “Save Driveway” button to save the new 

driveway to the map screen. 
11. Select the “Clear Driveway” button if you would like 

to redraw or cancel the driveway added. 
12. Select the “x” in the upper right corner of the “Add 

Driveways” pop up window to close the window. 

 
 To add a driveway by a coordinate. 
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1. Select the “Draw Driveway Using Origin Coordinates” 
button.  This will display the “Add Driveways” pop up 
window. 

2. Enter the X and Y coordinates of the beginning point 
of the driveway. 

3. Select the “Continue” button. This will place a point 
on the map screen. 

 
4. Double Left Mouse Click the end point of the 

driveway on the map screen.   
5. Follow the directions as above for adding a new 

driveway. 
 

 To remove a driveway. 
1. Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
2. Select the “Driveway” option from the Tools list. 
3. Select the “Remove” option from the Driveway list. 
4. This brings up the “Select Driveway to Remove” 

button. Select the button and your mouse pointer will 
become a cross symbol. 

5. Double Left Mouse Click on the driveway you would 
like to remove.  
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Road Permits 
 
The Road Permit Tool allows the user to add, modify or 
remove road permits from the map screen.   
 

 To add a road permit. 
1.  Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
2. Select the “Road Permit” option from the Tools list. 
3. Select the “Add” option from the Road Permit list.  

This will display the “Add Road Permit” pop up 
window. 

4. Select the “Draw Road Permit On Map” button.  Your 
mouse pointer will become a pencil symbol. 

5. Left Mouse Click on the map screen where the Road 
Permit is to be placed, keep selecting points until the 
last point is entered. 

6. Double Left Mouse Click the last point to add the line 
to the map screen. 

7. Select the “Get” button to select a permit number and 
ID number from the database. 

8. If you have the RP Number you may also enter this. 
9. Select the “Save Road Permit” button to save the new 

driveway to the map screen. 
10. Select the “Clear Road Permit” button if you would 

like to redraw or cancel the driveway added. 
11. Select the “x” in the upper right corner of the “Add 

Road Permit” pop up window to close the window. 
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 To remove a Road Permit. 

1.  Left Mouse Click the “Tools” menu option located at 
the top of the screen. 

2. Select the “Road Permit” option from the Tools list. 
3. Select the “Remove” option from the Road Permit list. 
4. This brings up the “Select Road Permit to Remove” 

button. Select the button and your mouse pointer will 
become a cross symbol. 

5. Double Left Mouse Click on the Road Permit you 
would like to remove.  

 
 To modify a Road Permit. 

1.  Left Mouse Click the “Tools” menu option located at 
the top of the screen. 

2. Select the “Road Permit” option from the Tools list. 
3. Select the “Modify” option from the Road Permit list. 
4. This brings up the “Select Road Permit to Modify” 

button. Select the button and your mouse pointer will 
become a cross symbol. 

5. Double Left Mouse Click on the Road Permit you 
would like to remove.  

6. The rest of the options are similar to the “Add Road 
Permit” functions. 
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Conceptuals 
 
The Conceptuals Tool allows the user to add, remove, or 
modify Conceptuals on the map screen. 
 

 To add a Conceptuals. 
1. Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
2. Select the “Conceptuals” option from the Tools list. 
3. Select the “Add” option from the Conceptuals list.  

This will display the “Add Conceptuals” pop up 
window. 

4. Select the “Get Conceptual Number” to automatically 
pick a number from the database or enter the 
Conceptuals Number. 

5. Select the “Draw Conceptual Shape” button located in 
the lower left corner of the pop up window. 

6. Left Mouse Click each point you would like to make 
for the Conceptual being added. 

7. Double Left Mouse Click on the last point to close the 
Conceptual shape being added. 

8. Select the “Save” button to save the new Conceptual. 
9. Select the “Clear” button if you would like to redraw 

or cancel the Conceptual added. 
10. Select the “x” in the upper right corner of the “Add 

Conceptual” pop up window to close the window. 
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 To remove a Conceptual. 

1. Left Mouse Click the “Tools” menu option located at the 
top of the screen. 

2. Select the “Conceptual” option from the Tools list. 
3. Select the “Remove” option from the Conceptual list.  

Your mouse pointer will become a cross symbol. 
4. Double Left Mouse Click on the Conceptual you would 

like to remove.  This will display the “Delete” pop up 
window. 

5. Select the “OK” button to remove the selected 
Conceptual. 

6. Select the “Cancel” button if you do not wish to remove 
the selected Conceptual. 
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 To modify a Conceptual. 
1. Left Mouse Click the “Tools” menu option located at the 

top of the screen. 
2. Select the “Conceptual” option from the Tools list. 
3. Select the “Modify” option from the Conceptual list.  

This will display the “Edit Conceptual” pop up window. 
Select the Conceptual to Edit on the screen. 

4. The user can enter a new Conceptual number in the box 
or select the “Get Conceptual Number” button to 
reselect from the database. 

5. Select the “Move” button if you would like to move a 
point for the selected Conceptual.  Then left mouse click 
the area on the screen you would like to move a point to.  
The system will select the closes point to be moved. 

6. Select the “Add” button if you would like to add a point 
for the selected Conceptual.  Then left mouse click the 
area on the screen you would like to add a point. 

7. Select the “Remove” button if you would like to remove 
a point form the selected Conceptual.  Then left mouse 
click the point on the screen you would like to remove. 

8. Select the “Save” button to save the changes made to the 
selected Conceptual. 

9. Select the “Clear” button if you would like to undo or 
cancel the changes to the selected Conceptual. 

10. Select the “x” in the upper right corner of the “Edit 
Outline” pop up window to close the window. 
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Trans233 
 
The Trans233 Tool allows the user to add, remove, or 
modify Trans233s on the map screen. 
 

 To add a Trans233. 
11. Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
12. Select the “Trans233” option from the Tools list. 
13. Select the “Add” option from the Trams233 list.  This 

will display the “Add Trans233” pop up window. 
14. Select the “Get Trans 233 Number” to automatically 

pick a number from the database or enter the Trans233 
Number. 

15. Select the “Draw Trans 233 Shape” button located in 
the lower left corner of the pop up window. 

16. Left Mouse Click each point you would like to make 
for the Trans233 being added. 

17. Double Left Mouse Click on the last point to close the 
Trans233 shape being added. 

18. Select the “Save” button to save the new Trans233. 
19. Select the “Clear” button if you would like to redraw 

or cancel the Trans233 added. 
20. Select the “x” in the upper right corner of the “Add 

Trans233” pop up window to close the window. 
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 To remove a Trans233. 

7. Left Mouse Click the “Tools” menu option located at the 
top of the screen. 

8. Select the “Trans233” option from the Tools list. 
9. Select the “Remove” option from the Trams233 list.  

Your mouse pointer will become a cross symbol. 
10. Double Left Mouse Click on the Trans233 you would 

like to remove.  This will display the “Delete” pop up 
window. 

11. Select the “OK” button to remove the selected Trans233. 
12. Select the “Cancel” button if you do not wish to remove 

the selected Trans233. 
 

 
 

1 

4 

6 5 



Chapter 5   Tools  44 

 

 To modify a Trans233. 
11. Left Mouse Click the “Tools” menu option located at the 

top of the screen. 
12. Select the “Trans233” option from the Tools list. 
13. Select the “Modify” option from the Trams233 list.  This 

will display the “Edit Trans 233” pop up window. Select 
the Trans233 to Edit on the screen. 

14. The user can enter a new Trans233 number in the box or 
select the “Get Trans233 Number” button to reselect 
from the database. 

15. Select the “Move” button if you would like to move a 
point for the selected Trans233.  Then left mouse click 
the area on the screen you would like to move a point to.  
The system will select the closes point to be moved. 

16. Select the “Add” button if you would like to add a point 
for the selected Trans233.  Then left mouse click the 
area on the screen you would like to add a point. 

17. Select the “Remove” button if you would like to remove 
a point form the selected Trans233.  Then left mouse 
click the point on the screen you would like to remove. 

18. Select the “Save” button to save the changes made to the 
selected Trans233. 

19. Select the “Clear” button if you would like to undo or 
cancel the changes to the selected Trans233. 

20. Select the “x” in the upper right corner of the “Edit 
Outline” pop up window to close the window. 
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Subdivision 
 
The Subdivision Tool allows the user to add, remove, or 
modify Subdivisions on the map screen.  This process is 
done once the user has enter the Subdivision request into 
the Tracking System. 
 

 To add a Subdivision. 
1. Left Mouse Click the “Tools” menu option located at 

the top of the screen. 
2. Select the “Subdivision” option from the Tools list. 
3. Select the “Add” option from the Subdivision list.  

This will display the “Add Subdivision” pop up 
window. 

4. Select the “Get Subdivision” button and pick from the 
database or enter the name into the box. 

5. Select the “Draw Subdivision” button. 
6. Left Mouse Click each point you would like to make 

for the Subdivision being added. 
7. Double Left Mouse Click on the last point to close the 

Subdivision shape being added. 
8. Select the “Save” button to save the new Subdivision. 
9. Select the “Clear” button if you would like to redraw 

or cancel the Subdivision added. 
10. Select the “x” in the upper right corner of the “Add 

Subdivision” pop up window to close the window. 
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 To remove a Subdivision. 

1. Left Mouse Click the “Tools” menu option located at the 
top of the screen. 

2. Select the “Subdivision” option from the Tools list. 
3. Select the “Remove” option from the Subdivision list.  

Your mouse pointer will become a cross symbol. 
4. Left Mouse Click on the Subdivision you would like to 

remove.  This will display the “Delete” pop up window. 
5. Select the “OK” button to remove the selected 

Subdivision. 
6. Select the “Cancel” button if you do not wish to remove 

the selected Subdivision. 
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 To modify a Subdivision. 
1. Left Mouse Click the “Tools” menu option located at the 

top of the screen. 
2. Select the “Subdivision” option from the Tools list. 
3. Select the “Modify” option from the Subdivision list.  

This will display the “Edit Outline” pop up window. 
4. Select the “Select Subdivision to Edit” button and select 

the subdivision on the screen. 
5. The user can enter a new Subdivision Name or slect the 

“Get Subdivision Name” button and select it from the 
list 

6. Select the “Move” button if you would like to move a 
point for the selected Subdivision.  Then left mouse 
click the area on the screen you would like to move a 
point to.  The system will select the closes point to be 
moved. 

7. Select the “Add” button if you would like to add a point 
for the selected Subdivision.  Then left mouse click the 
area on the screen you would like to add a point. 

8. Select the “Remove” button if you would like to remove 
a point form the selected Subdivision.  Then left mouse 
click the point on the screen you would like to remove. 

9. Select the “Save” button to save the changes made to the 
selected Subdivision. 

10. Select the “Clear” button if you would like to undo or 
cancel the changes to the selected Subdivision. 

11. Select the “x” in the upper right corner of the “Edit 
Outline” pop up window to close the window. 
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Street Labels 
 
The Street Labels function allows toggling the names of 
the streets on and off.  To view the labels it will be 
necessary to zoom in close enough to distinguish the 
actual streets. 

 

 To turn Street Labels on and off. 
1. Left Mouse Click the “Tools” menu option located at the 

top of the screen. 
2. Select the “Street Labels” option from the Tools list. 
3. Select the “Display On” option from the Street Labels 

list.  This will display the street labels on the map 
screen. 

4. Select the “Display Off” option from the Street Labels 
list.  This will remove the street labels from the map 
screen. 

5. You may also select the “Street Labels” button located at 
the right of the map screen. 
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Notes 
 
The Notes function allows the user to Add, Delete, or 
Move a comment or label at a specific location. 

 

 To add Notes. 
1. Left Mouse Click the “Tools” menu option located at the top of 

the screen. 
2. Select the “Notes” option from the Tools list. 
3. Select the “Add” option from the Notes list.  This will display 

the “Add Notes” pop up window. 
4. Enter the Note you would like to add into the textbox on the 

“Add Note” pop up winow. 
5. Select the “OK” button to add the note to the map screen. 
6. Select the “Cancel” button to cancel the changes of adding a 

note entered. 
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 To move Notes. 
1. Left Mouse Click the “Tools” menu option located at the top of 

the screen. 
2. Select the “Notes” option from the Tools list. 
3. Select the “Move” option from the Notes list.  Your mouse 

pointer will become a cross symbol. 
4. Left Mouse Click the note you would like to move. 
5. Left Mouse Click the new location to which you would like to 

move the note. 
Before 

 
After 

 
 

Note You may continue to select new locations for the 
selected note until another command has been chosen or 
until you right mouse click. 
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 To delete Notes. 
1. Left Mouse Click the “Tools” menu option located at the top of 

the screen. 
2. Select the “Notes” option from the Tools list. 
3. Select the “Delete” option from the Notes list.  Your mouse 

pointer will become a cross symbol. 
4. Left Mouse Click the note you would like to delete.  This will 

display the “Delete” pop up window. 
5. Select the “OK” button to remove the selected note. 
6. Select the “Cancel” button if you do not wish to remove the 

selected note. 
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 To change size of Notes. 
1. Left Mouse Click the “Tools” menu option located at the top of 

the screen. 
2. Select the “Notes” option from the Tools list. 
3. Select the “Change Size” option from the Notes list. 
4. Left Mouse Click the note for which you would like to change 

the size.  This will display then “Text Size” pop up window. 
5. Enter the new text size into the text box on the “Text Size” pop 

up window. 
6. Select the “OK” button to save size change to the selected note. 
7. Select the “Cancel” button if you do not wish to change the 

size of the selected note. 
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 To change the font of Notes. 
1. Left Mouse Click the “Tools” menu option located at the top of 

the screen. 
2. Select the “Notes” option from the Tools list. 
3. Select the “Change Font” option from the Notes list.  This with 

display the “Font” pop up window. 
4. Left Mouse Click the “Font” from the list. 
5. Select the “Font Style” from the list. 
6. Select the “Size” from the list. 
7. You may also select from the options under the “Effects” box. 
8. Select the “OK” button to keep the changes made. 
9. Select the “Cancel” button to cancel the changes requested. 

 
Note Any changes that are made will apply to all Notes that are 
on the screen and will also apply to new notes as well (unless the 
style is changed). 

 

 To clear all Notes. 
1. Left Mouse Click the “Tools” menu option located at the top of 

the screen. 
2. Select the “Notes” option from the Tools list. 
3. Select the “Clear All” option from the Notes list.  This with 

remove all notes from the map screen. 
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Mailing List 
 

 To add Notes. 
1. Left Mouse Click the “Tools” menu option located at the top of 

the screen. 
2. Select the “Mailing” option from the Tools list. 
3. Left Mouse Click each point you would like to include the 

range of owners that are to be included in the mailing list. 
4. Double Left Mouse Click to complete the range. 
5. Select the location you would like to save the list of names 

created. 
6. Enter the “File Name” you would like to save the mailing list 

as with an extention of “.txt”. 
7. Select the “Save” button to save the list. 
8. Select the “Cancel” button to cancel the save action. 

 
 

1 

3 

4 

5 

7 

6 

8 



Chapter 5   Tools  55 

 

Print 
 
If connected to a printer, this function will allow printing 
of the information that is currently displayed on the 
screen.  This function utilizes the default printer setup on 
the computer. 
 

 To print current map screen view. 
1. Left Mouse Click the “Print” menu option located at the top of 

the screen.  The “Print” pop up window will be displayed. 
2. Select the “Name” of the print to which you would like to 

print. 
3. Select the “Number of Copies” if you would like to print more 

than one copy of the map screen. 
4. Select the “OK” button to print map screen. 
5. Select the ‘Cancel” button to cancel the print action. 
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Adding and Editing Lists Menu 
 
 
 
 
 
 
 
 

When you want to add or edit data in the Tracking System, the Lists Menu 
allows you to set the options to most all drop down boxes through out the 
system.  To use this feature you must enter a password before the system 
will allow you to enter the Lists Menu Screen. 
 
Note If the Lists Menu are not entered or modified to fit the standards of 
the users needs the system will not work properly for the user. 
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Open Lists Menu 
 
On the Main Menu of the Tracking System select the “Lists 
Menu” button.  The system will prompt you for a password 
before you will be allowed to enter this screen. 
 
Note If you do not know the password and are suppose to 
have access to this area, please see your administrator. 

Selecting a List Option 
 
On the Lists Menu Screen you will notice there are two list 
boxes and some button options.  You will need to select 
which list option you would like to work with before you 
can add, remove, or edit the existing list. 
 

 To select an option 
1. Find which list option you would like to work with in the 

“List Options” list box. 
2. Left Mouse Click on the item of choice. 

This will display all the records of the “List Options” selected in 
the “Records List “ list box. 

 
 
Once you have chosen the list option that you would like to 
work with, a gray box is displayed at the right of the “List 
Options” list box.  This gray box is where you will add, 
remove, or edit the existing list. 
 
Note Please refer to the “Adding Records”, “Editing 
Records” and “Removing Records” sections of this chapter 
for details on how to do these functions. 
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Adding Records 
 
You will need to select which list option you would like 
before you can add a new record. 
 
Once you have chosen the list option that you would like to 
work with, a gray box is displayed to the right of the “List 
Options” list box.  This gray box is where you will add a 
new record. 
 

 To add a new record 
1. Find which list option you would like to work with in the 

“List Options” list box. 
2. Select the “Add New List Option” button, which is 

located below the gray box. 
3. You may now add the new information to the blank 

fields shown in the gray box. 

Editing Records 
 
You will need to select which list option you would like 
before you can edit a record’s information. 
 
Once you have chosen the list option that you would like to 
work with, a gray box is displayed to the right of the “List 
Options” list box.  This gray box is where you will edit a 
record. 
 

 To edit a record 
1. Find which list option you would like to work with in the 

“List Options” list box. 
2. Left Mouse Click the record you would like to modify 

from the “Records List” list box. 

 
3. You may now edit the information of the fields shown in 

the gray box. 
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Removing Records 
 
You will need to select which list option you would like 
before you can remove a record. 
 
Once you have chosen the list option that you would like to 
work with, a gray box is displayed to the right of the “List 
Options” list box.  This gray box is where you will remove a 
record. 
 

 To remove a record 
1. Find which list option you would like to work with in the 

“List Options” list box. 
2. Left Mouse Click the record you would like to remove 

from the “Records List” list box. 

 
 

3. Select the “Remove List Option” button, which is 
located below the gray box. 

The record that was selected should no longer be listed in the 
“Records List” list box and the gray box should now display the 
next record in the list. 

 
Note If the record you have selected is associated or being 
used by a record on the Entries Screen you cannot delete the 
selected record at this time.  You will need to remove the 
associations, to this list option, through out all the records in 
the system before you may continue with this process. 
 
 

Moving between Records 
 
On the Lists Menu Screen you will notice there are two list 
boxes and some button options.  You will need to select 
which list option you would like to work with before you 
can move between records of an existing list. 
 

 To move between records 
1. Find which list option you would like to work with in the 

“List Options” list box. 
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2. Left Mouse Click on the item of choice. 
This will display all the records of the “List Options” selected in 
the “Records List “ list box. 

 
3. Left Mouse Click the record you would like to move to 

in the “Records List” list box. 

 
 

Once you have selected the record from the “Records List” 
list box, the gray box will display the information of the 
selected record. 
 

Open Letter Templates 
 
On the Main Menu of the Tracking System select the “Lists 
Menu” button.  The system will prompt you for a password 
before you will be allowed to enter this screen. 
 
On the Lists Menu Screen you will notice there are two 
button options in the lower left corner of the Screen.  You 
will need to select the button option “Letter Types” to open 
the Letter Templates Screen. 
 
Note If you do not know the password and are suppose to 
have access to this area, please see your administrator. 
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Adding Records 
 

 To add a new record 
1. Open the Letter Templates Screen 
2. Select the “Add New Letter” button located at the top, 

middle of the screen. 
3. Enter the Letter Name and Body information 
4. Select the “Save” button located at the top, right of the 

screen. 

Editing Records  
 

 To edit a record 
1. Open the Letter Templates Screen 
2. Use the drop down box to select the letter template you 

wish to edit. 
 

 
 

3. Edit the information in the body of the letter template 
selected. 

4. Select the “Save” button located at the top, right of the 
screen, when you are done editing the selected letter. 
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Removing Records 
 

 To remove a record 
1. Open the Letter Templates Screen 
2. Use the drop down box to select the letter template you 

wish to remove. 

 
 

3. Select the “Delete Letter” button located at the top, 
middle of the screen. 

 
Note If the record you have selected is associated or being 
used by a record on the Entries Screen you cannot delete the 
selected record at this time.  You will need to remove the 
associations, to this list option, through out all the records in 
the system before you may continue with this process. 
 

Moving between Records 
 

 To move between records 
1. Open the Letter Templates Screen 
2. Use the drop down box to select the letter template you 

would like to move to. 
 

 
 

Open Form Templates 
 
On the Main Menu of the Tracking System select the “Lists 
Menu” button.  The system will prompt you for a password 
before you will be allowed to enter this screen. 
 
On the Lists Menu Screen you will notice there are two 
button options in the lower left corner of the Screen.  You 
will need to select the button option “Form Types” to open 
the Form Templates Screen. 
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Note If you do not know the password and are suppose to 
have access to this area, please see your administrator. 

Editing Records 
 
On the Form Templates Screen you will notice that once you 
have selected a form template from the drop down box, 
certain paragraph fields are grayed out.  The program does 
not look for the fields that are grayed out when producing 
the finished forms that are being created for the specified 
Log Entry. 
You will also notice that some forms have more than one 
paragraph part.  This is due to the information that is 
automatically pulled from the specified Log Entry. 
 
Example (at the beginning of this phrase) “County Name” 
(automatically pulled) “Paragraph Part 1” - County, State of 
Wisconsin, contained the following error (if more space is needed, 
please attach addendum) (between Part 1 and Part 2) “Highway” 
(automatically pulled) “Paragraph Part 2” - Affiant make this 
Affidavit for the purpose of correcting the above document as 
follows (if more space is needed, please attached addendum): 
 

 To edit a record 
1. Open the Form Templates Screen 
2. Use the drop down box to select the form template you 

wish to edit. 
 

 
 

5. Edit the information in the body of the form template 
selected. 

6. Select the “Return to Previous” button located at the top, 
right of the screen, when you are done editing the 
selected form. 

Moving between Records 
 

 To move between records 
1. Open the Form Templates Screen 
2. Use the drop down box to select the form template you 

would like to move to. 
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Sorting the List Boxes 
 

 To sort the list box 
1. Left Mouse Click the column name of the list box. 
 
Tip You can sort the list by more than one column. 
How If you have a column named “First Name” and 
another column named “Last Name” and you would like to 
sort them by Last Name then First name you will want to: 
(1) Select the First Name column  
(2) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
(3) You will then want to select the Last Name column 
(4) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
 
Note If the column is already in ascending order it will be 
put in descending order when you left mouse click the 
column name. 
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Adding and Editing Lists of Contacts 
 
 
 
 
 
 

This chapter will explain how to create Contacts for the Tracking System.  
The Contacts that are created are then used to help the users to create letters 
and forms that are then sent to the Contacts. 
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Open Lists of Contacts 
 
On the Main Menu of the Tracking System select the “List 
of Contacts” button.  If you are on the Log Entries Screen 
select the “Open Contact List” link. 

Adding Records 
 

 To add a new record 
1. Select the “Add” button, which is located at the middle, 

right of the screen. 
2. You may now add the new information to the blank 

fields shown on the screen. 
 
Note The fields that are highlighted in light blue will only 
accept a number. 

Editing Records 
 

 To edit a record 
1. Find which person you would like to work with from the 

list box, located at the bottom of the screen. 
2. Left Mouse Click the record you would like to modify 

from the list box. 

 
3. You may now edit the information of the fields shown on 

the screen. 

Removing Records 
 

 To remove a record 
1. Find which person you would like to remove from the 

list box, located at the bottom of the screen. 
2. Left Mouse Click the record you would like to remove 

from the list box. 

 
 

3. Select the “Remove” button, which is located at the 
middle, right of the screen. 
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The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

 
Note If the record you have selected is associated or being 
used by a record on the Entries Screen you cannot delete the 
selected record at this time.  You will need to remove the 
associations, to this contact, through out all the records in the 
system before you may continue with this process. 

Moving between Records 
 

 To move between records 
1. Find which person you would like to work with from the 

list box, located at the bottom of the screen. 
2. Left Mouse Click on the item of choice. 

 
 Or 
3. You can also move between records by selecting the 

navigation buttons located at the middle, right of the 
screen. 

Finding a Specific Record 
 

 To find a specific record 
1. Enter the first few letters of the person you are trying to 

find into one or more of the four boxes. 

 
2. Select the “Find” button to display the matching results 

into the list box. 
3. Select the “Reset” button to display the full list of 

contacts in the list box. 
 

 



Chapter 2   Adding and Editing Lists of Contacts 13 

Sorting the List Box 
 

 To sort the list box 
1. Left Mouse Click the column name of the list box. 
 
Tip You can sort the list by more than one column. 
How If you have a column named “First Name” and 
another column named “Last Name” and you would like to 
sort them by Last Name then First name you will want to: 
(1) Select the First Name column  
(2) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
(3) You will then want to select the Last Name column 
(4) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
 
Note If the column is already in ascending order it will be 
put in descending order when you left mouse click the 
column name. 
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Adding and Editing Log Entries 
 
 
 
 

This chapter will explain how to add and edit information on and associated 
with a Log Entry in the Tracking System. 
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Add Log Entries 
 
On the Main Menu of the Tracking System select the “Log 
Entries” button to open the Log Entries Screen. 
 

 To add a new Log Entry 
1. Open the Log Entries Screen 
2. Select the “Add New Entry” button located at the top, 

left of the screen. 
3. Fill in the fields that are located in the upper portion of 

the screen, above the tabs. 
 
Note You will always want to fill in the County Name, 
Highway and Municipality of an entry.  These three pieces 
of information are used extensively elsewhere in the 
Tracking System. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Entries List” tab will 
display a list of all the log entries currently in the Tracking 
System.  With this list you are able to select a log and it will 
then be displayed in the fields on the Log Entries Screen. 
 

 To edit a record 
1. Locate the Log Entry you would like to work with by 

selecting the “Entries List” tab located in the middle of 
the screen. 

2. Left Mouse Click the record you would like to modify 
from the list box. 

 
 Or 
3. You may also locate a Log Entry by selecting the 

navigation buttons located at the middle, right of the 
screen. 
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4. You may now edit the information of the fields shown on 
the screen. 

Moving between Records 
 

 To move between records 
1. Select the “Entries List” tab located in the middle of the 

screen. 
2. Left Mouse Click the record you would like to move to 

from the list box. 

 
 Or 
3. You may also move between records by selecting the 

navigation buttons located at the middle, right of the 
screen. 

 
 

Add Access Request 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Access” tab will display 
a list of all the Access Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To add Access Request 
1. Locate the Log Entry that is to be associated with the 

Access Request. 
2. Select the “Access” tab located in the middle of the 

screen. 

 
 
3. Select the “Add Access Request” button located at the 

right of the tab. 
4. You may now enter the information into the blank fields 

located on the tab. 
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Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Access” tab will display 
a list of all the Access Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the Access 

Request. 
2. Select the “Access” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the tab. 

4. You may now edit the information of the fields shown on 
the tab. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Access” tab will display 
a list of all the Access Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the Access 

Request. 
2. Select the “Access” tab located in the middle of the 

screen. 
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3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the tab. 

4. Select the “Remove Access Request” button located at 
the right of the tab. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Access” tab will display 
a list of all the Access Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To move between records 
1. Select the “Access” tab located in the middle of the 

screen. 

 
 

2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the tab. 

 
Add Conceptual Request 

 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Conceptual” tab will 
display a list of all the Conceptual Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To add Conceptual Request 
1. Locate the Log Entry that is to be associated with the 

Conceptual Request. 
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2. Select the “Conceptual” tab located in the middle of the 
screen. 

 
 

3. Select the “Add Conceptual Request” button located at 
the right of the tab. 

4. You may now enter the information into the blank fields 
located on the tab. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Conceptual” tab will 
display a list of all the Conceptual Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the Conceptual 

Request. 
2. Select the “Conceptual ” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the tab. 

4. You may now edit the information of the fields shown 
on the tab. 
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Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Conceptual” tab will 
display a list of all the Conceptual Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the Conceptual 

Request. 
2. Select the “Conceptual ” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the tab. 

4. Select the “Remove Conceptual Request” button located 
at the right of the tab. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Conceptual” tab will 
display a list of all the Conceptual Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To move between records 
1. Select the “Conceptual ” tab located in the middle of the 

screen. 
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2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the tab. 

 
Add RPs 

 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the RPs.  These records are associated 
with the Log Entry displayed at the top of the screen. 
 

 To add RPs 
1. Locate the Log Entry that is to be associated with the RP. 
2. Select the “Location” tab located in the middle of the 

screen. 

 
 

3. Select the “Add RP” button located at the top, left of the 
“RP Information” box. 

4. You may now enter the information into the blank fields 
located in the “RP Information” box. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the RPs that are associated with the Log 
Entry displayed at the top of the screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the RP. 
2. Select the “Location” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the “RP 
Information” box. 

 
 Or 
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4. You may also locate a record by selecting the navigation 
buttons located at the left of the “RP Information” box. 

 
 

5. You may now edit the information of the fields shown in 
the “RP Information” box. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the RPs.  These records are associated 
with the Log Entry displayed at the top of the screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the RP. 
2. Select the “Location” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the “RP 
Information” box. 

 
4. Select the “Remove RP” button located at the top, left of 

the “RP Information” box. 
The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the RPs.  These records are associated 
with the Log Entry displayed at the top of the screen. 
 

 To move between records 
1. Select the “Location” tab located in the middle of the 

screen. 
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2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the “RP 
Information” box. 

 
 Or 
3. You may also move between records by selecting the 

navigation buttons located at the left of the “RP 
Information” box. 

 
 

Add Legal Location 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display the first record of the Legal Location.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To add Legal Location 
1. Locate the Log Entry that is to be associated with the 

Legal Location. 
2. Select the “Location” tab located in the middle of the 

screen. 

 
 

3. Select the “Add Legal Location” button located at the 
bottom left of the tab. 

4. You may now enter the information into the blank fields 
and toggle buttons located on the tab. 

 
Note The fields that are inside the “RP Information” box and 
the “Government Lot Information” box are not part of the 
Legal Location Entry. 
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Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display the first record of the Legal Location.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the Legal Location. 
2. Select the “Location” tab located in the middle of the 

screen. 

 
 

3. Locate the record you would like to modify by selecting 
the navigation buttons located at the bottom, left of the 
tab. 

 
 

4. You may now edit the information into the blank fields 
and toggle buttons located on the tab. 

 
Note The fields that are inside the “RP Information” box and 
the “Government Lot Information” box are not part of the 
Legal Location Entry. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display the first record of the Legal Location.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the Legal Location. 
2. Select the “Location” tab located in the middle of the 

screen. 
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3. Locate the record you would like to remove by selecting 
the navigation buttons located at the bottom, left of the 
tab. 

 
 

4. Select the “Remove Legal Location” button located at 
the bottom, left of the tab. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display the first record of the Legal Location.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To move between records 
1. Select the “Location” tab located in the middle of the 

screen. 

 
 

2. Locate the record you would like to move to by selecting 
the navigation buttons located at the bottom, left of the 
tab. 

 
 

Add Government Lots 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the Government Lots.  These lots are 
associated with the Legal Location currently displayed at the 
left of the “Government Lot Information” box. 
 

 To add Government Lots 
1. Locate the Log Entry associated with the Legal Location. 
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2. Select the “Location” tab located in the middle of the 
screen. 

 
 

3. Locate the Legal Location that is to be associated with 
the Government Lot. 

4. Select the Legal Location Entry by selecting the 
navigation buttons located at the bottom, left of the tab. 

 
 

5. Select the “Add Gov’t Lot” button located at the left of 
the “Government Lot Information” box. 

6. You may now enter the information into the blank field 
located in the “Government Lot Information” box. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the Government Lots.  These lots are 
associated with the Legal Location currently displayed at the 
left of the “Government Lot Information” box. 
 

 To edit a record 
1. Locate the Log Entry associated with the Legal Location. 
2. Select the “Location” tab located in the middle of the 

screen. 

 
 

3. Locate the Legal Location that is associated with the 
Government Lot. 

4. Select the Legal Location Entry by selecting the 
navigation buttons located at the bottom, left of the tab. 
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5. Left Mouse Click the record you would like to modify 
from the list box located at the right of the “Government 
Lot Information” box. 

 
 Or 
6. You may also locate a record by selecting the navigation 

buttons located at the bottom of the “Government Lot 
Information” box. 

7. You may now edit the information of the field shown in 
the “Government Lot Information” box. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the Government Lots.  These lots are 
associated with the Legal Location currently displayed at the 
left of the “Government Lot Information” box. 
 

 To remove a record 
1. Locate the Log Entry associated with the Legal Location. 
2. Select the “Location” tab located in the middle of the 

screen. 

 
 

3. Locate the Legal Location that is associated with the 
Government Lot. 

4. Select the Legal Location Entry by selecting the 
navigation buttons located at the bottom, left of the tab. 

 
 

5. Left Mouse Click the record you would like to remove 
from the list box located at the bottom of the 
“Government Lot Information” box. 

 
 



Chapter 3   Adding and Editing Log Entries 29 

6. Select the “Remove Gov’t Lot” button located at the left 
of the “Government Lot Information” box. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Location” tab will 
display a list of all the Government Lots.  These lots are 
associated with the Legal Location currently displayed at the 
left of the “Government Lot Information” box. 
 

 To move between records 
1. Select the “Location” tab located in the middle of the 

screen. 

 
 

2. Left Mouse Click the record you would like to move to 
from the list box located at the right of the “Government 
Lot Information” box. 

 
 Or 
3. You may also move between records by selecting the 

navigation buttons located at the left of the “Government 
Lot Information” box. 
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Add Permit Request 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Permit” tab will display 
a list of all the Permit Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To add Permit Request 
1. Locate the Log Entry that is to be associated with the 

Permit Request. 
2. Select the “Permit” tab located in the middle of the 

screen. 

 
 

3. Select the “Add Permit Request” button located at the 
right of the tab. 

4. You may now enter the information into the blank fields 
located on the tab. 

 
Note The “Permit” tab has a series of tabs located in the 
middle of the tab.  Selecting these tabs will allow the user to 
enter information in all fields of the “Permit” tab. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Permit” tab will display 
a list of all the Permit Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To edit a record 
1. Locate the Log Entry that is to be associated with the 

Permit Request. 
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2. Select the “Permit” tab located in the middle of the 
screen. 

 
 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the tab. 

4. You may now edit the information of the fields shown 
on the tab. 

 
Note The “Permit” tab has a series of tabs located in the 
middle of the tab.  Selecting these tabs will allow the user to 
edit information of all fields on the “Permit” tab. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Permit” tab will display 
a list of all the Permit Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To remove a record 
1. Locate the Log Entry that is to be associated with the 

Permit Request. 
2. Select the “Permit” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the tab. 

4. Select the “Remove Permit Request” button located at 
the right of the tab. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 
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Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Permit” tab will display 
a list of all the Permit Requests.  These requests are 
associated with the Log Entry displayed at the top of the 
screen. 
 

 To move between records 
1. Select the “Permit” tab located in the middle of the 

screen. 

 
 

2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the tab. 

 
Add Subdivision Request 

 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Subdivision” tab will 
display a list of all the Subdivision Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To add Subdivision Request 
1. Locate the Log Entry that is to be associated with the 

Subdivision Request. 
2. Select the “Subdivision ” tab located in the middle of the 

screen. 

 
 
3. Select the “Add Subdivision Request” button located at 

the right of the tab. 
4. You may now enter the information into the blank fields 

located on the tab. 
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Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Subdivision” tab will 
display a list of all the Subdivision Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the Subdivision 

Request. 
2. Select the “Subdivision ” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the tab. 

4. You may now edit the information of the fields shown on 
the tab. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Subdivision” tab will 
display a list of all the Subdivision Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the Subdivision 

Request. 
2. Select the “Subdivision ” tab located in the middle of the 

screen. 
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3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the tab. 

4. Select the “Remove Access Request” button located at 
the right of the tab. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Subdivision” tab will 
display a list of all the Subdivision Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To move between records 
1. Select the “Subdivision ” tab located in the middle of the 

screen. 

 
 

 

2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the tab. 

 
Add Traffic Impact Analysis Request 

 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “TIA” tab will display a 
list of all the Traffic Impact Analysis Requests.  These 
requests are associated with the Log Entry displayed at the 
top of the screen. 
 

 To add Access Request 
1. Locate the Log Entry that is to be associated with the 

Traffic Impact Analysis Request. 
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2. Select the “TIA” tab located in the middle of the screen. 
 

 
 

3. Select the “Add TIA Request” button located at the right 
of the tab. 

4. You may now enter the information into the blank fields 
located, on the tab. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “TIA” tab will display a 
list of all the Traffic Impact Analysis Requests.  These 
requests are associated with the Log Entry displayed at the 
top of the screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the Traffic Impact 

Analysis Request. 
2. Select the “TIA” tab located in the middle of the screen. 
 

 
 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the tab. 

4. You may now edit the information of the fields shown 
on the tab. 
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Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “TIA” tab will display a 
list of all the Traffic Impact Analysis Requests.  These 
requests are associated with the Log Entry displayed at the 
top of the screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the Traffic Impact 

Analysis Request. 
2. Select the “TIA” tab located in the middle of the screen. 
 

 
 

3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the tab. 

4. Select the “Remove TIA Request” button located at the 
right of the tab. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “TIA” tab will display a 
list of all the Traffic Impact Analysis Requests.  These 
requests are associated with the Log Entry displayed at the 
top of the screen. 
 

 To move between records 
1. Select the “TIA” tab located in the middle of the screen. 
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2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the tab. 

 
Add Trans233 Request 

 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Trans233” tab will 
display a list of all the Trans233 Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To add Trans233 Request 
1. Locate the Log Entry that is to be associated with the 

Trans233 Request. 
2. Select the “Trans233” tab located in the middle of the 

screen. 

 
 
3. Select the “Add Trans233 Request” button located at the 

right of the tab. 
4. You may now enter the information into the blank fields, 

located on the tab. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Trans233 ” tab will 
display a list of all the Trans233 Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the Trans233 

Request. 
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2. Select the “Trans233” tab located in the middle of the 
screen. 

 
 

 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the tab. 

4. You may now edit the information of the fields shown on 
the tab. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Trans233” tab will 
display a list of all the Trans233 Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the Trans233 

Request. 
2. Select the “Trans233” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the tab. 

4. Select the “Remove Trans233 Request” button located at 
the right of the tab. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 
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Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Trans233 ” tab will 
display a list of all the Trans233 Requests.  These requests 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To move between records 
1. Select the “Trans233 ” tab located in the middle of the 

screen. 

 
 

2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the tab. 

 
Add Activity Log Records 

 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Activity Log” tab will 
display a list of all the Activity Log Records.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To add Activity Log Records 
1. Locate the Log Entry that is to be associated with the 

Activity Log Records. 
2. Select the “Activity Log” tab located in the middle of the 

screen. 

 
 
3. Select the “Add Activity” button located at the right of 

the tab. 
4. You may now enter the information into the blank fields, 

located on the tab. 
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Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Activity Log” tab will 
display a list of all the Activity Log Records.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To edit a record 
1. Locate the Log Entry associated with the Activity Log 

Records. 
2. Select the “Activity Log” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the tab. 

4. You may now edit the information of the fields shown on 
the tab. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Activity Log” tab will 
display a list of all the Activity Log Records.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To remove a record 
1. Locate the Log Entry associated with the Activity Log 

Records. 
2. Select the “Activity Log” tab located in the middle of the 

screen. 

 
 

3. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the tab. 
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4. Select the “Remove Activity” button located at the right 
of the tab. 

The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in the 
list. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Selecting the “Activity Log” tab will 
display a list of all the Activity Log Records.  These records 
are associated with the Log Entry displayed at the top of the 
screen. 
 

 To move between records 
1. Select the “Activity Log” tab located in the middle of the 

screen. 

 
 

2. Left Mouse Click the record you would like to move to 
from the list box, located at the bottom of the tab. 

 
Add To Do List Records 

 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Six of these tabs are referred to as 
request tabs.  Selecting an individual request on one of these 
six tabs “Access”, “Conceptual”, “Permit”, “Subdivision”, 
“TIA”, or “Trans233” will display a list of all associated To 
Do Entries. 
 

 To add To Do List Records 
1. Locate the Log Entry associated with the individual 

request. 
2. Locate the individual request that is to be associated with 

the To Do List Record by selecting one of the following 
tabs: 
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3. Select the individual request from the list box located at 
the bottom of the tab. 

 
 

4. Select the “Edit To Do Entries” button located at the 
bottom, left of the tab.  The To Do List Screen will be 
displayed. 

5. On the To Do List Screen select the “Add” button 
located at the top, right of the screen. 

6. You may now enter information into the blank fields of 
the To Do List Screen. 

 
Note To Close the To Do List Screen select the “X” located 
in the upper right hand corner of the screen. 

Editing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Six of these tabs are referred to as 
request tabs.  Selecting an individual request on one of these 
six tabs “Access”, “Conceptual”, “Permit”, “Subdivision”, 
“TIA”, or “Trans233” will display a list of all associated To 
Do Entries. 
 

 To edit a record 
1. Locate the Log Entry associated with the individual 

request. 
2. Locate the individual request that is to be associated with 

the To Do List Record by selecting one of the following 
tabs: 

 

 
 

3. Select the individual request from the list box located at 
the bottom of the tab. 

 
 

4. Select the “Edit To Do Entries” button located at the 
bottom, left of the tab.  The To Do List Screen will be 
displayed. 
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5. Left Mouse Click the record you would like to modify 
from the list box, located at the bottom of the To Do List 
Screen. 

 
 Or 
6. You may also select the record you would like to modify 

by selecting the navigation buttons located above the list 
box. 

7. You may now edit the information in the fields of the To 
Do List Screen. 

 
Note To Close the To Do List Screen select the “X” located 
in the upper right hand corner of the screen. 

Removing Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Six of these tabs are referred to as 
request tabs.  Selecting an individual request on one of these 
six tabs “Access”, “Conceptual”, “Permit”, “Subdivision”, 
“TIA”, or “Trans233” will display a list of all associated To 
Do Entries. 
 

 To remove a record 
1. Locate the Log Entry associated with the individual 

request. 
2. Locate the individual request that is to be associated with 

the To Do List Record by selecting one of the following 
tabs: 

 

 
 

3. Select the individual request from the list box located at 
the bottom of the tab. 

 
 

4. Select the “Edit To Do Entries” button located at the 
bottom, left of the tab.  The To Do List Screen will be 
displayed. 
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5. Left Mouse Click the record you would like to remove 
from the list box, located at the bottom of the To Do List 
Screen. 

 
 Or 
6. You may also select the record you would like to remove by 

selecting the navigation buttons located above the list box. 
7. On the To Do List Screen select the “Remove” button 

located at the top, right of the screen. 
The record that was selected should no longer be listed in the 
list box and the fields should now display the next record in 
the list. 

 
Note To Close the To Do List Screen select the “X” located 
in the upper right hand corner of the screen. 

Moving between Records 
 
The Log Entries Screen has a series of tabs located in the 
middle of the screen.  Six of these tabs are referred to as 
request tabs.  Selecting an individual request on one of these 
six tabs “Access”, “Conceptual”, “Permit”, “Subdivision”, 
“TIA”, or “Trans233” will display a list of all associated To 
Do Entries. 
 

 To move between records 
1. On the To Do List Screen Left Mouse Click the record 

you would like to move to from the list box, located at 
the bottom of the screen. 

 

 
 Or 
2. You may also select the record you would like to move to by 

selecting the navigation buttons located above the list box. 
 
Note To Close the To Do List Screen select the “X” located 
in the upper right hand corner of the screen. 
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Sorting the List Box 
 

 To sort the list box 
1. Left Mouse Click the column name of the list box. 
 
Tip You can sort the list by more than one column. 
How If you have a column named “First Name” and 
another column named “Last Name” and you would like to 
sort them by Last Name then First name you will want to: 
(1) Select the First Name column  
(2) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
(3) You will then want to select the Last Name column 
(4) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
 
Note If the column is already in ascending order it will be 
put in descending order when you left mouse click the 
column name. 
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C H A P T E R  4  
 
Adding and Removing Log Entry Contacts 
 
 
 
 
 

This chapter will explain how to add and remove associated contacts from a 
log entry.  Knowing how to add contacts to be associated with a log entry is 
very import for the Tracking System.  If you are unable to add a contact, 
Letters and Forms will not be able to work properly for your needs. 
 
Note You cannot change how contacts information is displayed from the 
Edit Associated Contacts Screen.  Changes to “General Contacts” can only 
be done in the Contacts Screen.  “Municipal Contacts” cannot be changed; 
they are automatically updated by the Revenue Department every month. 
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Find Contacts to be Associated 
 
On the Log Entries Screen the “Associated Contacts” list 
box displays a list of all Associated Contacts to the current 
Log Entry. Selecting the “Edit Contact List” button will 
open the Edit Associated Contacts Screen. 
 
On this screen you will notice there are three list boxes.  The 
list box located at the top displays a list matching the one on 
the Log Entries Screen.  The list box in the middle displays 
all General Contacts in the Tracking System, and the list box 
at the bottom displays all Municipal Contacts in the 
Tracking System. 
 

 To find contacts to be associated 
1. Located the Log Entry for which you would like to 

remove an associated contact. 
2. On the Log Entries Screen select the “Edit Contact List” 

button located above the “Associated Contacts” list box.  
This will display the Edit Associated Contacts Screen. 

3. To find a General Contact enter the search criteria in the 
four fields located above the “General Contacts” list box. 

 

 
 

4. Select the “Find” button located to the right of these four 
fields.  The “General Contacts” list box will display all 
matching Contacts. 

5. To find a Municipal contact enter the search criteria in 
the three fields located above the “Municipal Contacts” 
list box. 

 

 
 

6. Select the “Find” button located to the right of these 
three fields.  The “Municipal Contacts” list box will 
display all matching Contacts. 

7. Select the “Reset” button located above the “General 
Contacts” and “Municipal Contacts” list boxes to reset 
the search criteria for the corresponding list box. 
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Add Associated Contacts 

 
On the Log Entries Screen the “Associated Contacts” list 
box displays a list of all Associated Contacts to the current 
Log Entry. Selecting the “Edit Contact List” button will 
open the Edit Associated Contacts Screen. 
 
On this screen you will notice there are three list boxes.  The 
list box located at the top displays a list matching the one on 
the Log Entries Screen.  The list box in the middle displays 
all General Contacts in the Tracking System, and the list box 
at the bottom displays all Municipal Contacts in the 
Tracking System. 
 

 To add associated contacts 
1. Locate the Log Entry for which you would like to add an 

associated contact. 
2. On the Log Entries Screen select the “Edit Contact List” 

button located above the “Associated Contacts” list box.  
This will display the Edit Associated Contacts Screen. 

3. Find the Contacts you would like to associate in the 
“General Contacts” and “Municipal Contacts” list boxes 
located at the middle and bottom of the screen. 

 
 

4. Place a check mark next to the Contacts you would like 
to associate in the list boxes. 

5. Select the “Add Selected Contacts to List” button located 
at the top, right of the screen.  This will display a screen 
for you to identify each contacts type. 

6. Select the “Type of Contact” for the contact displayed 
and then select the “OK” button.  Each contact that was 
selected will be displayed one at a time until a type has 
been identified for each. 
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Remove Associated Contacts 
 
On the Log Entries Screen the “Associated Contacts” list 
box displays a list of all Associated Contacts to the current 
Log Entry. Selecting the “Edit Contact List” button will 
open the Edit Associated Contacts Screen. 
 
On this screen you will notice there are three list boxes.  The 
list box located at the top displays a list matching the one on 
the Log Entries Screen.  The list box in the middle displays 
all General Contacts in the Tracking System, and the list box 
at the bottom displays all Municipal Contacts in the 
Tracking System. 
 

 To remove associated contacts 
1. Located the Log Entry for which you would like to 

remove an associated contact. 
2. On the Log Entries Screen select the “Edit Contact List” 

button located above the “Associated Contacts” list box.  
This will display the Edit Associated Contacts Screen. 

3. Find the Contacts you would like to remove in the 
“Currently Associated Contacts” list box located at the 
top of the screen. 

 
 

4. Place a check mark next to the Contacts you would like 
to remove from the list box. 

5. Select the “Remove Selected Associated Contacts from 
List” button located at the top, right of the screen.  This 
will remove all check marked Contacts from the 
Associated List. 

 
Create New Contact to be Associated 

 
On the Log Entries Screen the “Associated Contacts” list 
box displays a list of all Associated Contacts to the current 
Log Entry. Selecting the “Edit Contact List” button will 
open the Edit Associated Contacts Screen. 
 
On this screen you will notice there are three list boxes.  The 
list box located at the top displays a list matching the one on 
the Log Entries Screen.  The list box in the middle displays 
all General Contacts in the Tracking System, and the list box 
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at the bottom displays all Municipal Contacts in the 
Tracking System. 
 
Note This feature is used only after you have used the Find 
options and are still unable to locate the Contact needed. 
 

 To create new contact to be associated 
1. Located the Log Entry for which you would like to add 

an associated contact. 
2. On the Log Entries Screen select the “Edit Contact List” 

button located above the “Associated Contacts” list box.  
This will display the Edit Associated Contacts Screen. 

3. Select the “Create New Contact and Add to List” button 
located at the top, right of the screen. 

4. Enter all of the information into the fields displayed on 
the screen.  Select the “Type of Contact” your adding. 

5. Select the “Add” button located at the bottom, right of 
the screen. 

 
Note This feature will add the new contact to the “General 
Contacts” list box and the “Currently Associated Contacts” 
list box. 
 
 

Sorting the List Boxes 
 

 To sort the list boxes 
1. Left Mouse Click the column name of the list box. 
 
Tip You can sort the list by more than one column. 
How If you have a column named “First Name” and 
another column named “Last Name” and you would like to 
sort them by Last Name then First name you will want to: 
(1) Select the First Name column  
(2) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
(3) You will then want to select the Last Name column 
(4) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
 
Note If the column is already in ascending order it will be 
put in descending order when you left mouse click the 
column name. 
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C H A P T E R  5  
 
Adding and Editing Permit Applications 
 
 
 
 
 

Permit Applications allow users to enter Permit Application information 
quickly and produce printed copies of the information for the applicant.  
This chapter will explain how to add, edit, print and email permit 
applications. 
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Open Permit Applications 
 
On the Main Menu of the Tracking System select the 
“Entries” button.  On the Log Entries Screen locate the log 
entry associated with the permit application.  Select the 
permit tab on the tab set. On the permit tab select the dates 
tab and locate the permit you would like to open the 
application for and press the “Open Permit Applications” 
button located at the top of the permit tab. 
 

Create a New Permit Application 
 

 To create a new permit application 
1. Locate the log entry associated with the permit. 
2. Select the permit tab of the tab set. 
3. Select the date tab of the permit section. 
4. Select the permit from the list box and press the “Open 

Permit Application” button. 
5. This will open the Permit Application screen. 
6. Select the type of Permit Application to create from the 

drop down menu at the top of the screen. 
7. Once you have chosen the option you want, select the 

“Create New Permit” button located to the left of the 
drop down box. 

8. You may now enter the information for the permit 
application. 

 
Note To go to the second page of the permit application 
select the “Go to Page 2 à” button located at the bottom, 
right of the screen.  When you want to return to the first page  
of the permit application select the “Go to Page 1 à” button 
located at the bottom, right of the screen. 

Edit a Permit Application 
 

 To edit a permit application 
1. Locate the log entry associated with the permit. 
2. Select the permit tab of the tab set. 
3. Select the date tab of the permit section. 
4. Select the permit from the list box and press the “Open 

Permit Application” button. 
5. This will open the Permit Application screen. 
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6. Locate the permit application you would like to modify 
by selecting the navigation buttons located at the top, 
middle of the Permit Application Screen. 

 

 

Move between Permit Applications 
 

 To move between permit applicaitons 
1. If the permit you have selected has more than one permit 

application then you would select the navigation buttons 
located at the top, middle of the Permit Application 
Screen. 

 

 Or 
2. If  the application you are looking for is associated with 

a different permit number then you will need to select 
the “Return to Previous” button and locate the proper 
permit number and then select the “Open Permit 
Applications” button on the dates tab of the permit tab 
set. 

Print Permit Applications 
 

 To print permit applications 
1. Locate the log entry associated with the permit. 
2. Select the permit tab of the tab set. 
3. Select the date tab of the permit section. 
4. Select the permit from the list box and press the “Open 

Permit Application” button. 
5. This will open the Permit Application screen. 
6. Locate the permit application you would like to print by 

selecting the navigation buttons located at the top, 
middle of the Permit Application Screen. 

 
7. Select the “Print Preview” link located at the top, right of 

the screen. 
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8. Select the “Print” button located on the toolbar at the top 
of your screen.  This will print a copy of the permit 
application to your default printer. 

 

Print Driveway Checklist 
 

 To print permit applications 
1. Locate the log entry associated with the permit. 
2. Select the permit tab of the tab set. 
3. Select the date tab of the permit section. 
4. Select the permit from the list box and press the “Open 

Permit Application” button. 
5. This will open the Permit Application screen. 
6. Locate the driveway permit application you would like 

to print the driveway checklist for, by selecting the 
navigation buttons located at the top, middle of the 
Permit Application Screen. 

 
7. Select the “Print Checklist” link located at the top, right 

of the screen. 
8. Select the “Print” button located on the toolbar at the top 

of your screen.  This will print a copy of the driveway 
checklist to your default printer. 

  
Note The Driveway Checklist only prints the Permit 
Applicants Name and the Highway and County information. 
The other information on this form is to be entered by hand 
in the field and then placed in the data fields on the permit 
tab section of the log entries screen. 
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Email Permit Applications 
 

 To email permit applications 
1. Open the permit application you would like to email. 
2. The permit application should be displayed in Microsoft 

Access. 
3. Select the “File” menu located in the top left corner of 

your screen.  Select the “Send to” option and then the 
“Mail to Recipient (as attachment)”.  The “Send” pop-up 
will be displayed. 

4. Chose a format from the list and select the “OK” button.  
Your e-mail window will be displayed.  Enter the 
information as you would normally when sending an 
email. 

 
Note You will need to identify which format your recipient 
will be able to read before selecting an option.  The lines that 
are displayed for the form will not transfer in an email unless 
the Snapshot Format is chosen. 
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C H A P T E R  6  
 
Adding and Editing Letters 
 
 
 
 
 

Letters are a very import part of the Tracking System.  They allow users to 
create standard letters very quickly and produce envelopes for the recipient 
and courtesy copy recipients.  This chapter will explain how to add, edit 
and keep a legal copy of the letters associated to a log entry. 
 
Note Users are unable to make changes to letters that have been marked 
as sent.  The sent option is to allow the system to maintain the legal value 
of the letter.  Marking the letter sent will place a comment in the Activity 
Log for the log entry, which lets users know that the correspondence has 
taken place. 
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Open Letters 
 
On the Main Menu of the Tracking System select the 
“Entries” button.  On the Log Entries Screen locate the log 
entry associated with the letter.  Select the “Open Letters” 
link located at the right of the screen. 

Create a New Letter 
 

 To create a new letter 
1. Locate the log entry to be associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Select the drop down box located at the top, middle of 

the Letters Screen. 
4. Selecting a letter option will display the content of the 

body for the letter option selected. 
5. Once you have chosen the option you want, select the 

“Create New Letter” button located to the left of the drop 
down box. 

6. You may now enter the information for the letter and 
change the content of the body to suit your needs. 

 
Note To add your signature and courtesy copies select the 
“Page Down” button located at the top, right of the screen.  
When you want to return to the content of your letter select 
the “Page Up” button located at the top, right of the screen. 

Edit Letters 
 

 To edit letters 
1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Locate the letter you would like to modify by selecting 

the navigation buttons located at the top, right of the 
Letters Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
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at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

5. You may now edit the information for the letter and 
change the content of the body to suit your needs. 

 
Note To change your signature or courtesy copies select 
the “Page Down” button located at the top, right of the 
screen.  When you want to return to the content of your letter 
select the “Page Up” button located at the top, right of the 
screen. 

Remove Letters 
 

 To remove letters 
1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Locate the letter you would like to remove by selecting 

the navigation buttons located at the top, right of the 
Letters Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

5. Select the “Remove Letter” button located at the top, left 
of the screen. 

 
Note Letters that have been marked as sent cannot be 
removed from the Tracking System. 
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Move between Letters 
 

 To move between letters 
1. Select the letter you would like to move to by selecting 

the navigation buttons located at the top, right of the 
Letters Screen. 

 
 Or 
2. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

 
Modifying Letters for Print and Email 

 
On the Main Menu of the Tracking System select the 
“Entries” button.  On the Log Entries Screen locate the log 
entry associated with the letter.  Select the “Open Letters” 
link located at the right of the screen.  On the Letters Screen 
locate the letter you would like to modify the formatting for 
printed copies and e-mails.  Select the “Print Preview” link 
located at the top right of the screen.  

Modify Letter Formatting 
 

 To modify the letters 
1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Locate the letter you would like to print by selecting the 

navigation buttons located at the top, right of the Letters 
Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 
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5. Select the “Print Preview” link located at the top, right of 
the screen. 

6. Left mouse click and hold down the left mouse button 
while you drag it over the part(s) of the letter until you 
have highlighted what you would like to modify. 

 
7. Select the first drop down on the left to modify the color 

of the highlighted information. 
8. Select the second drop down from the left to modify the 

font and the third drop down from the left to modify the 
font size of the highlighted information. 

 
9. Select the “B”, “I”, or “U” button located at the top of 

the Print Letter Screen to modify the Bold, Italic, or 
Underline formatting of the highlighted information. 

 
Note When you close the Print Letter Screen you loose all 
formatting that has been done.  The formatting does not get 
saved at any time during the process of modifying the letter. 

Print Letters 
 

 To print letters 
1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
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3. Locate the letter you would like to print by selecting the 
navigation buttons located at the top, right of the Letters 
Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

5. Select the “Print Preview” link located at the top, right of 
the screen. 

6. Select the “Print” button located on the toolbar at the top 
of your screen.  This will print a copy of the letter to 
your default printer. 

 

Email Letters 
 

 To email letters 
1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Locate the letter you would like to email by selecting the 

navigation buttons located at the top, right of the Letters 
Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

5. Select the “Print Preview” link located at the top, right of 
the screen. 
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6. Select the “Send Email” button located at the top right of 
the Print Letter Screen.  This will attach the letter to an 
email. 

 
 
Customize Envelopes 

 
 To customize envelopes 

1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Locate the letter you would like to modify by selecting 

the navigation buttons located at the top, right of the 
Letters Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

5. Select the “Envelopes” link located at the top, right of 
the screen.  The Envelopes Screen will be displayed. 

6. Left Mouse Click the envelope you would like to 
customize in the list box located at the bottom of the 
screen. 

7. You may now edit the information in the fields located 
above the list box for the selected envelope. 

Remove Envelopes 
 

 To remove envelopes 
1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
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3. Locate the letter you would like to remove by selecting 
the navigation buttons located at the top, right of the 
Letters Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

5. Select the “Envelopes” link located at the top, right of 
the screen.  The Envelopes Screen will be displayed. 

6. Left Mouse Click the envelope you would like to remove 
in the list box located at the bottom of the screen. 

 
7. Select the “Remove Selected Record” button located at 

the top, left of the screen. 
The record that was selected should no longer be listed in the 
list box. 

Move between Envelopes 
 

 To move between envelopes 
1. On the Envelopes Screen Left Mouse Click the envelope 

you would like to move to in the list box located at the 
bottom of the screen. 
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Print Envelopes 
 

 To print envelopes 
1. Locate the log entry associated with the letter. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Locate the letter you would like to print envelopes for by 

selecting the navigation buttons located at the top, right 
of the Letters Screen. 

 
 Or 
4. You may also view a list of all letters for the current log 

entry by selecting the “View List of Letters” link located 
at the top, right of the screen.  Selecting one of the letters 
listed will take you to that letter. 

5. Select the “Envelopes” link located at the top, right of 
the screen.  The Envelopes Screen will be displayed. 

6. Select the “Print Preview” button located at the top, 
middle of the screen. 

7. Select the “Print” button located on the toolbar at the top 
of your screen.  This will print a copy of the print to your 
default printer. 

 
Note If the envelopes being displayed for print are not in 
envelope form the page setup will need to be modified.  To 
do this: 
(1) Select the “File” menu located in the upper left corner of 

the screen. 
(2) Select the “Page Setup” option from the menu list. 
(3) Select the “Page” tab located at the top of the pop-up 

window. 
(4) Select the “Size” drop down located in the “Paper” box 

in the middle of the pop-up window.  Change the option 
to Envelope #10. 

(5) Select the “OK” button located at the bottom of the pop-
up window. 

 



Chapter 6   Adding and Editing Letters 65 

Sorting the List Boxes 
 

 To sort the list boxes 
1. Left Mouse Click the column name of the list box. 
 
Tip You can sort the list by more than one column. 
How If you have a column named “First Name” and 
another column named “Last Name” and you would like to 
sort them by Last Name then First name you will want to: 
(1) Select the First Name column  
(2) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
(3) You will then want to select the Last Name column 
(4) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
 
Note If the column is already in ascending order it will be 
put in descending order when you left mouse click the 
column name. 
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C H A P T E R  7  
 
Adding and Editing Forms 
 
 
 
 

Forms are a very import part of the Tracking System.  They allow users to 
create standard forms very quickly.  This chapter will explain how to add, 
edit and keep a legal copy of the forms associated to a log entry. 
 
Note Users are unable to make changes to forms that have been marked 
as sent.  The sent option is to allow the system to maintain the legal value 
of the form.  Marking the form sent will place a comment in the Activity 
Log for the log entry, which lets users know that the correspondence has 
taken place. 
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Open Forms 
 
On the Main Menu of the Tracking System select the 
“Entries” button.  On the Log Entries Screen locate the log 
entry associated with the form.  Select the “Open Forms” 
link located at the right of the screen. 

Create a New Form 
 

 To create a new form 
1. Locate the log entry to be associated with the form. 
2. Select the “Open Forms” link located at the right of the 

screen. 
3. Select the drop down box located at the top, middle of 

the Forms Screen. 
4. Once you have chosen the option you want, select the 

“Create New Form” button located to the left of the drop 
down box. 

5. You may now enter the information for the form. 

Edit Forms 
 

 To edit forms 
1. Locate the log entry associated with the form. 
2. Select the “Open Forms” link located at the right of the 

screen. 
3. Select the form you would like to move to by selecting 

the navigation buttons located at the top, right of the 
Forms Screen. 

 
4. You may now edit the information for the form. 

Remove Forms 
 

 To remove forms 
1. Locate the log entry associated with the form. 
2. Select the “Open Forms” link located at the right of the 

screen. 
3. Select the form you would like to move to by selecting 

the navigation buttons located at the top, right of the 
Forms Screen. 
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4. Select the “Remove Form” button located at the top, left 

of the screen. 
 
Note Forms that have been marked as sent cannot be 
removed from the Tracking System. 

Move between Forms 
 

 To move between forms 
1. Select the form you would like to move to by selecting 

the navigation buttons located at the top, right of the 
Forms Screen. 

 

Print Forms 
 

 To print forms 
1. Locate the log entry associated with the form. 
2. Select the “Open Forms” link located at the right of the 

screen. 
3. Select the form you would like to move to by selecting 

the navigation buttons located at the top, right of the 
Forms Screen. 

 
4. Select the “Print Preview” link located at the top, right of 

the screen. 
5. Select the “Print” button located on the toolbar at the top 

of your screen.  This will print a copy of the form to your 
default printer. 
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Email Forms 
 

 To email forms 
1. Locate the log entry associated with the form. 
2. Select the “Open Letters” link located at the right of the 

screen. 
3. Select the form you would like to move to by selecting 

the navigation buttons located at the top, right of the 
Forms Screen. 

 
4. Select the “Print Preview” link located at the top, right of 

the screen. 
5. Select the “File” menu located in the top left corner of 

your screen.  Select the “Send to” option and then the 
“Mail to Recipient (as attachment)”.  The “Send” pop-up 
will be displayed. 

6. Chose a format from the list and select the “OK” button.  
Your e-mail window will be displayed.  Enter the 
information as you would normally when sending an 
email. 

 
Note You will need to identify which format your recipient 
will be able to read before selecting an option.  The lines that 
are displayed for the form will not transfer in an email unless 
the Snapshot Format is chosen. 
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C H A P T E R  8  
 
Searching for Log Entries 
 
 
 
 
 

This chapter will explain how to search the Tracking System for the Log 
Entry you would like to find. 
 
Note The search can sometime take a few moments to load the data that 
was found in the Tracking System. 
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Open Search Screen 
 
On the Main Menu of the Tracking System select the 
“Search” button to open the Search Screen. 
 

General Search 
 
On the Search Screen there are three gray boxes, which 
allow the user to select search criteria from the combo boxes 
located with in the gray boxes.  The matching information is 
displayed in the corresponding list box located below or to 
the right of the gray box with the selected criteria. 
 
Note Selecting an option one combo box changes the 
options available in all other combo boxes not yet selected 
from with in the gray boxes. 

 Search By: 

 Request Type 
1. Open the Search Screen from the Main Menu. 
2. Select the Request Type you would like to Search 

By located at the top, middle of the screen. 

 
3. The matching results will be displayed in the list 

boxes located on the screen. 

 Location Information 
1. Open the Search Screen from the Main Menu. 
2. Select a combo box from the “Location 

Information” gray box located at the middle left 
of the screen. 

 
3. The matching results will be displayed in the list 

boxes located on the screen. 
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 Legal Location 
1. Open the Search Screen from the Main Menu. 
2. Select a combo box from the “Legal Location” 

gray box located at the left of the screen. 

 
3. The matching results will be displayed in the list 

boxes located on the screen. 

 RP Information 
1. Open the Search Screen from the Main Menu. 
2. Select a combo box from the “RP Information” 

gray box located at the left of the screen. 

 
3. The matching results will be displayed in the list 

boxes located on the screen. 
 

Specific Search 
 
On the Search Screen there is a field called “Log Number” 
and a combo box called “Development Name”.  These two 
fields allow a user to go to the specific Log Entry with out 
searching by criteria. 
 
Note Using these options will not change what is currently 
displayed in the list boxes located on the screen. 

 Log Number 
1. Open the Search Screen on the Main Menu. 
2. Enter the Log Entry Number into the “Log Number” 

field. 
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 Development Name 
1. Open the Search Screen on the Main Menu. 
2. Select the Development Name from the combo box. 

 

 
 

3. This will place the Log Entry Number of the 
Development Name selected into the “Log Number” 
field. 

 Permit Number 
1. Open the Search Screen on the Main Menu. 
2. Select the Search by Permit Information button. 

 

 
 

3. This will open the Searcy by Permit Information screen. 

  
4. Enter the permit number in the Permit Field and select 

the Find Permit Number button. 

 Permit Location 
1. Open the Search Screen on the Main Menu. 
2. Select the Search by Permit Information button. 

 

 
 

3. This will open the Searcy by Permit Information screen. 
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4. Select from any or all of the drop down boxes to select 

the location information and then select the Find 
Driveway Location button. 

 
Note Selecting one or two drop down options is 
recommended verses selecting all. 

 

Display Selected Record 
 

 To display the selected record 
1. Open the Search Screen on the Main Menu. 
2. Select the search criteria to locate the Log Entry you 

would like to display. 
3. If you are doing a “General Search” you will need to 

select the record you would like to display from one of 
the list boxes located on the screen. 

 
4. Select the “Open Log Entries” button located at the right 

of the screen.  This will display the Log Entries Screen 
with the selected record. 

 
Clear Form 

 
This feature is used when you want to start your search 
criteria over.  This will remove any selections that have been 
place on the screen and all records displayed in the list boxes 
will be removed. 
 

 To clear the form 
1. Open the Search Screen on the Main Menu. 
2. Select the “Clear Form” button located at the right of the 

screen.  This will clear all selections. 
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Sorting the List Boxes 

 
 To sort the list boxes 

1. Left Mouse Click the column name of the list box. 

Tip You can sort the list by more than one column. 
How If you have a column named “First Name” and 
another column named “Last Name” and you would like to 
sort them by Last Name then First name you will want to: 
(1) Select the First Name column  
(2) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
(3) You will then want to select the Last Name column 
(4) Identify if you want the column to be sorted in 

“ascending” or “descending” order. 
 
Note If the column is already in ascending order it will be 
put in descending order when you left mouse click the 
column name. 
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C H A P T E R  9  
 
Viewing and Printing Reports 
 
 

 
 
This chapter will explain how to view and print reports that are in the 
Tracking System. 
 
Note Users can request to have new reports add to their Tracking System.  
The user will want to have a detailed list of items they would like to see in 
their report and have their Tracking System Administrator process the 
request. 
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Open Log Entry Report 
 
The Log Entry Report can be open from the Log Entries 
Screen or the Search Screen. 
 

 To open Log Entry Report 

 Log Entries Screen 
1. Open the Log Entries Screen by selecting the 

“Log Entries” button on the Main Menu. 
2. Locate the Log Entry for which you would like to 

view the report by selecting the navigation 
buttons located at the middle, right of the screen. 

 Or 
3. You may also locate the Log Entry by selecting 

the “Entries List” tab and Left Mouse Click the 
record from the list located at the bottom of the 
tab. 

4. Select the “Open Log Entry Report” link locate at 
the top, right of the screen. 

5. Microsoft Access will open displaying the Log 
Entry Report with the selected Log Number. 

 Search Screen 
1. Open the Search Screen by selecting the “Search” 

button on the Main Menu. 
2. Locate the Log Entry for which you would like to 

view the report by using the search options on the 
screen.  Then Left Mouse Click the record from 
any of the lists located on the screen. 

3. Select the “Open Log Entry Report” button 
located in the middle of the screen. 

4. Microsoft Access will open displaying the Log 
Entry Report with the selected Log Number. 

 
Note The log number for which you would like to 
view the report needs to be displayed in the Log 
Number field located at the top, left of the screen.  
The report will not open if this field does not display 
a log number. 
 

Open All Other Reports 
 

 To open all other reports 
1. On the Main Menu select the “Reports” button to display 

the Reports Screen. 
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2. On the Reports Screen use the drop down box in the 
center of the screen to select the report you would like to 
open. 

3. Once you have the report you would like to open 
displayed in the drop down box select the “OK” button. 

4. Microsoft Access will open displaying the selected 
Report, or a form that lets you chose options for the 
selected report. 

 
Print Reports 

 
 To print reports 

1. Open the report you would like to print. 
2. The report should be displayed in Microsoft Access. 
3. Select the “Print” button located on the toolbar at the top 

of your screen.  This will print a copy of the report to 
your default printer. 

 
Tip If you would like to print to a different printer, select 
the “File” menu located in the upper left corner of the 
window.  Then select the “Print” option from the menu list.  
This will open the Print Properties.  Use the drop down 
located at the top of Print Properties window to select a 
different printer. 
 

Email Reports 
 

 To email reports 
1. Open the report you would like to email. 
2. The report should be displayed in Microsoft Access. 
3. Select the “File” menu located in the top left corner of 

your screen.  Select the “Send to” option and then the 
“Mail to Recipient (as attachment)”.  The “Send” pop-up 
will be displayed. 

4. Chose a format from the list and select the “OK” button.  
Your e-mail window will be displayed.  Enter the 
information as you would normally when sending an 
email. 

 
Note You will need to identify which format your recipient 
will be able to read before selecting an option.  The lines that 
are displayed for the form will not transfer in an email unless 
the Snapshot Format is chosen. 
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C H A P T E R  1 0  
 
Creating and Setting Up New Reports 
 
 
 
 

The current list of reports that the user can use within the Tracking System 
can be modified and added to.  This chapter will explain how to add new 
reports to the Tracking System and will explain where you create and set up 
these new reports. 
 
Note Users can request to have new reports added to their Tracking 
System.  The user will want to have a detailed list of items they would like 
to see in their report and have their Tracking System Administrator process 
the request. 
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Creating New Reports 
 
Reports are created in the Microsoft Access database that 
stores the Tracking System information.  To create a new 
report you will need to open the database and go to the 
reports menu option.  To understand the table structures of 
the database please refer to the Access Determination 
Tracking System Design Manual.  This will aid you in 
setting up queries to fit the report being created. 
 
Note  You will want to be familiar with how to create 
reports in Microsoft Access. 
 

Setting Up New Reports 
 
Reports must be named using the following standards to set 
them up for the Tracking System. 
(1) You must start the name of your report as “rpt_” or the 

Tracking System will not add the report to the reports 
list. 

(2) Reports must NOT be named starting with “rpt_I_” or 
the Tracking System will not add them to the reports list.  
Reports that are named with the prefix “rpt_I_” are 
considered internal reports only. 

 
Setting Up Report Options 

 
This feature is used when you want to allow the user to 
create a more specific report based on criteria. 
 

 To set up report options 
1. Open the Tracking System Database. 
2. Create a query that has the parameter(s) needed to set the 

criteria options for the report. 
3. Create a form that allows the users to select or enter the 

parameter(s) option(s). 
4. Name the form “frm_” + “report name”. 

Example: Report Name = “rpt_New_Report” 
  Form Name  = “frm_New_Report” 

 
Note  If the form name is not spelled exactly like the report 
name the system will not display the criteria option when the 
user requests the report. 
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Modifying Existing Reports 
 

 To modify existing reports 
1. Open the Tracking System Database. 
2. Locate the report you would like to modify. 
3. Open report in design view and make the necessary 

changes. 
4. Save changes on close of the report. 
 

Notes of Caution 
 
The system will not function properly if the reports that are 
named with the prefix “rpt_I_” are re-named or if the 
following reports are modified:  

1. “rpt_I_Development”  
2. “rpt_I_Dev_Gov_Lots” 
3. “rpt_I_Dev_Location” 
4. “rpt_I_Dev_Requests” 
5. “rpt_I_Driveway” 
6. “rpt_I_DrivewayChecklist” 
7. “rpt_I_DrivewayPart1” 
8. “rpt_I_DrivewayPart2” 
9. “rpt_I_Envelopes”  
10. “rpt_I_Forms” 
11. “rpt_I_Forms_Top_L” 
12. “rpt_I_Forms_Top_R” 
13. “rpt_I_RightOfWay” 
14. “rpt_I_RWPage2” 
15. “rpt_I_RWPage3” 
16. “rpt_I_RWPage4” 
17. “rpt_I_RWSpecialNBs” 
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A p p e n d i x  A  
 
Correcting and Saving Data 
 
 
 
 

When is Data Saved? 
 
Whenever you change data on a screen, the Tracking System 
automatically saves your changes as soon as you move to 
another field, or when you close the current screen and open 
another. 
 
You don’t have to tell the Tracking System to save the 
changes you make to records.  If you make a mistake, 
though, you can correct it.  For information on making 
corrections, see “Correcting Mistakes with the Undo 
Command”. 
 

Correcting Mistakes with the Undo Command 
 
The Tracking System remembers the last change you made 
to your data until you change records or until you go to 
another screen.  If you type data incorrectly, you can tell the 
Tracking System to undo the changes. 
 

 To correct mistakes 
1. Place cursor into the field for which you would like to 

undo changes. 
2. Right Mouse Click and the pop-up menu will be 

displayed.  The options the system has available 
currently at that time will be in black text. 

3. Select the “Undo” menu command.  This will undo the 
changes that have taken place. 

 Or 
4. You may press the “CTRL+Z” keys on your keyboard.  

This will also undo the changes that have taken place. 
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A p p e n d i x  B  
 
Keyboard Techniques 
 
 
 

The following table lists keyboard techniques that can be used through out the 
Tracking System. 
 
To Do this 

Move to Next field Press TAB 

Move to Previous field Press SHIFT+TAB 

Moves to First space in a field Press HOME 

Moves to Last space in a field Press END 

Highlight all text from cursor to Start of 
field Press CTRL+SHIFT+HOME 

Highlight all text from cursor to End of 
field Press CTRL+SHIFT+END 

Add a tab to a field with text Press CTRL+TAB 

Move the insertion point with in a field Press the ARROW KEYS 

Undo changes to current field Press CTRL+Z 

Insert a new line character with in a field Press Enter, CTRL+Enter, CTRL+J, 
or CTRL+M 

Open a combo box list to display choices Press F4 

Copy selected text Press CTRL+C 

Cut selected text Press CTRL+X 

Past copied text Press CTRL+V 

Delete previous character Press CTRL+H or Backspace 
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A p p e n d i x  C  
 
Mouse Techniques 
 
 
 

Right clicking the mouse will display the following pop-up window: 
 

 
 

This pop-up window will only display the options that are available to 
you at the current time you have Right Mouse Clicked.  If you do not 
have an option available to you at the current time the following will 
be displayed in the pop-up window: 
 

 
 

Placing your mouse curser between column headings in a list box will 
allow you to readjust the current width of the column on left of your 
curser.  This adjustment is only temporary when you go to a new 
record or leave the form the column width will automatically resize. 
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Scanned Documents/Digital Image Files 
 
There are three types of images that the system is setup to handle. Trans 233 images, Permit images, and 
Subdivision Images. If there is an image that does not fit into these categories, then use the Trans233 other 
document type. 
 
Location and Naming 
 
The locations for storing the images will follow the directory listings below, starting with computer/server, 
followed by landdivs, scanneddocs, county name, and type. 
 
Trans233 Documents (A trans233 document is any document that is not a subdivision or permit.) 
\\wke32h31910\gis\landdivs\scanneddocs\Waukesha\Trans233\   
This subdirectory will house all of the types of Trans233 scans, including csm's, access covenants, 
conceptuals, and others. The naming conventions of them will be:   T00001001.pdf  –  The T is for csm, A 
will be used for access covenants, C for conceptuals, and O for others. The next five numbers is the log 
number (This must be five characters). The last three numbers will be a consecutive number starting at 001 
(This must be three characters). They will be saved in Adobe Acrobat (pdf) format. Any existing files 
acquired from local sources such as certified survey maps will also be stored as pdf files and will be named 
by the county assigned csm numbers. The format may be tif, jpg or pdf, but the user must have the viewer 
installed for the file type on their pc. 
 
Permit Documents (A permit document is a digital image of a driveway permit.) 
\\wke32h31910\gis\landdivs\scanneddocs\Waukesha\Permits\   
The naming scheme for permits will correspond to the permit number which will now be the driveway 
number that is assigned to an access point when it is entered into the GIS system. These digital images will 
also be stored in pdf format. For complete naming standards for driveways refer to the driveway naming 
standards section below. 
 
Subdivision Documents (A subdivision document is a digital image of a subdivision plat.) 
\\wke32h31910\gis\landdivs\scanneddocs\Waukesha\Subdivisions\ 
Subdivision documents will be named by their actual name, for example: Rogers Fifth Addition. The 
naming cannot have special characters within it. Use only numbers or letters when assigning the names. 
They will also be stored in pdf format. 
 
For standardization of scanning documents, refer to the WisDOT standards for image creation and scanning. 
The following are excerpts from those documents: 
 
Standard resolution for scanned images is 300 DPI for small plats and 200-300 DPI for 22 x 34 size plats.  
Central Office can only do 200 or 400, so we suggest doing 200 DPI, in that case. If you hire a consultant, 
use 300 DPI. Scan all plats at original size, do not reduce them. 
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Shape File Setups 
 
Driveway (Access Point) Shape Files 
 
Drives shape files are poly lines.   
The files were created by the following process: 

1. GPS locations were collected, utilizing a Trimble ProXR (1-meter differentially corrected unit). 
2. These points were collected in Wisconsin State Plane South Coordinates and converted in post 

processing to WTM NAD 83.  
3. The point were then converted to lines relating the points to the state trunk network and 

extending them approximately 50 feet from the centerline location of the STN. 
4. The CADD files were then converted to shape files. 
5. Each county area is separated and stored in countywide files. 
 

The dbf file contains the following fields: 

FIELD NAME TYPE WIDTH 

Shape Polyline   
Entity String 14 
Layer String 32 
Level Number 25  
Elevation Number 25  
Color Number 25  
Drives Number 25 
Lognum Number 25 
RP String 40 
XCoord Number 25 
YCoord Number 25 
Drivenum String 25 
RQST_ID Number 10 
 
Naming Standard for Driveway Segments 
Driveway numbering Legend: TT#RR #SC#### 
  TT Township (ex: 01 or 12) 
  #  Township direction (ex: N, S) 
  RR Range (ex: 01 or 12) 
  #  Range direction (ex: E, W) 
  SC Section 
  #### A number starting at one, for each individual driveway within that section  
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regardless of the highway or direction. (ex: 0001)  
 
 
Trans233 (ecsm) Shape File 
 
Ecsm shape files are polygons.   
These files are generated in one of two ways: 

1. Some counties separate their certified survey maps into separate shape/cad/gis files. We then just 
acquire them and use them as a base to begin from. 

2. Other counties store this information within their descriptions fields in their databases, which we 
connect to the mapping and then create the ecsm shape files from them, or merge properties 
together to create the files. 

 
The dbf file contains the following fields: 

FIELD NAME TYPE WIDTH 

Shape Polygon   
Lognum Number 25 
Csm_Num1 String 25 
RQST_ID Number 10 
 
Subdivision Shape File 
 
Subdiv shape files are polygons.   
These files are generated in one of two ways: 

1. Some counties separate their subdivisions into separate shape/cad/gis files. We then just acquire 
them and use them as a base to begin from. 

2. Other counties store this information within their descriptions fields in their databases, which we 
connect to the mapping and then create the subdiv shape files from them, or merge properties 
together to create the files. 

 
The dbf file contains the following fields: 

FIELD NAME TYPE WIDTH 

Shape Polygon   
Lognum Number 25 
Subd_Name1 String 100 
RQST_ID Number 10 
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Public Land Survey System Shape File 
 
PLSS shape files are polygons. The PLSS files can come from several sources. Regional planning 
commissions typically maintain them, some counties maintain them, and the DNR has a statewide coverage 
of them. 
 
The dbf file contains the following fields: 

FIELD NAME TYPE WIDTH 

Shape Polygon   
Tag String 32 
 
 
Streets Shape File 
 
Streets shape files are polylines. Street centerline files for local roads has been an issue throughout the 
project. The intent was to incorporate the local roads database, but the production of that system has been 
delayed and slow coming. In District 2, we utilized their GDT data sets. We trimmed the datasets to the 
county borders and created separate streets shape files for each county. 
 
 
Properties Shape File 
 
Props shape files are polygons. Props shape files are the most work out of the entire application. All 
counties have different configurations of file formats and fields included with them. We took a selection of 
counties in the District 2 area and polled them to see what they had for data and attribute information. With 
this information in mind, we developed a parcel attribute table set with assistance from a cross-functional 
group at District 2. The parcels from the county along with the tax assessment attribute information are 
compiled and converted into this format. We are currently working on automating that task for District 2. 
 
The dbf file contains the following fields: 

FIELD NAME TYPE WIDTH 
Shape Polygon  
PAR_NUM1 String 50 
LAYER String 32 
LEVEL String 32 
ELEVATION Number 25 
COLOR Number 25 
ENTITY String 25 
PRCL_NB String 50 
TAX_ID_NB String 13 
FNM_1 String 50 
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LNM_1 String 50 
FNM_2 String 50 
LNM_2 String 50 
OWNR_1 String 30 
OWNR_2 String 30 
ORG String 255 
MADR_1 String 30 
MADR_2 String 30 
MLCT String 21 
MLST String 2 
MAIL_ZIP Number 50 
MAIL_ZIP_PLUS String 255 
SRCH_NM_1 String 20 
SRCH_NM_2 String 15 
DIR_1 String 1 
HSE_1 String 5 
DIR_2 String 1 
HSE_2 String 5 
SRCH_STR_ NM String 20 
MUNI String 5 
TAX_YR Number 50 
ALTV_TAX_KY String 22 
SCHL_DIST String 4 
DIST_CD_1 String 2 
DIST_CD_2 String 2 
DIST_CD_3 String 2 
DIST_CD_4 String 2 
DIST_CD_5 String 2 
DIST_CD_6 String 2 
DIST_CD_7 String 2 
DIST_CD_8 String 2 
DIST_CD_9 String 2 
DIST_CD_10 String 2 
TOT_ACRE String 9 
TOT_LAND Number 50 
TOT_IMPT Number 50 
TOT_VAL Number 50 
FMV Number 50 
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RO Number 50 
LGL_DESC_1 String 30 
LGL_DESC_2 String 30 
LGL_DESC_3 String 29 
LGL_DESC_4 String 31 
LGL_DESC_5 String 30 
LGL_DESC_6 String 30 
LGL_DESC_7 String 30 
LGL_DESC_8 String 30 
LGL_DESC_9 String 30 
LGL_DESC_10 String 30 
LGL_DESC_11 String 30 
LGL_DESC_12 String 30 
LGL_DESC_13 String 255 
LGL_DESC_14 String 255 
LGL_DESC_15 String 255 
LGL_DESC_16 String 255 
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WisDOT Standard Shape Files 
 
The application uses several standard DOT shape files including: 
 
Meta-Manager.shp from Central Office DOT 
Counties.shp from DOA 
CVT.shp from DOA 
Water.shp from DOA 
Raillines.shp from DOA 
Sthbase.shp from STN Group 
Connecthwy.shp from STN Group 
Bridge.shp from STN Group 
Row.shp from D2  
Orthos.shp created from aerial photo boundaries 
Accesstypes.shp from Central Office 
  



Pilot Study 
 
WisDOT decided to conduct a pilot study for an area that would have most of the 
controls that they can utilize in place. They chose the STH 60 corridor area in 
Washington County. This area incorporated several different situations and held to be a 
well selected section. The pilot project area included rural townships, a large community, 
a small community and some rural populated areas. There were several access controls in 
place throughout the project area, including: Wisconsin TRANS 233 areas, subdivision 
restrictions, certified survey map restrictions, 84.25 Access Control areas, 84.295 Access 
Control areas, freeways, rural state trunk highways and several different roadway 
networking configurations. 
 
The pilot study had existing data available for the project, including digital subdivision 
and survey maps, roadway centerline mapping and other data sources. The area did not 
have parcel mapping available yet and this effort needed to be completed. 
 
The study was successful and yielded some minor changes in the scope of the original 
project, including: adding the functionality of drawing tools, the development of a larger 
database application to include the functionality of creating forms/letters and other 
needed documentation.  
 
Implementation 
 
The project is still currently being finalized and over the last several years has developed 
into an extensive database application that is used throughout every step of Access 
review in several of the department’s district offices. The application is also being looked 
at to be incorporated into a larger enterprise application for display of the relating data 
through an IMS application.
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